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END-USER LICENSE AGREEMENT
BY ACCEPTING, YOU (ORIGINAL PURCHASER) INDICATE YOUR ACCEPTANCE OF THESE 
TERMS. IF YOU DO NOT WISH TO ACCEPT THE PRODUCT UNDER THESE TERMS YOU MAY 
CHOOSE NOT TO ACCEPT BY SELECTING "I decline..." AND NOT INSTALLING THE 
SOFTWARE. 

The Acronis True Image Enterprise Server (the Software) is Copyright © Acronis, Inc., 2000-
2005. All rights are reserved. The ORIGINAL PURCHASER is granted a LICENSE to use the 
software only, subject to the following restrictions and limitations. 

1. The license is to the original purchaser only, and is not transferable without prior written 
Permission from Acronis. 

2. The Original Purchaser may use the Software on a single computer owned or leased by 
the Original Purchaser. You may not use the Software on more than a single machine 
even if you own or lease all of them without the written consent of Acronis. 

3. The Original Purchaser may not engage in, nor permit third parties to engage in, any of 
the following: 

A. Providing or permitting use of or disclosing the Software to third parties. 

B. Providing use of the Software in a computer service business, network, timesharing or 
multiple user arrangement to users who are not individually licensed by Acronis. 

C. Making alterations or copies of any kind in the Software (except as specifically permitted 
above). 

D. Attempting to un-assemble, de-compile or reverse engineer the Software in any way. 

E. Granting sublicenses, leases, or other rights in the Software to others. 

F. Making copies, or verbal or media translations, of the users guide. 

G. Making telecommunication data transmission of the software. 

Acronis has the right to terminate this license if there is a violation of its terms or default by 
the Original Purchaser. Upon termination for any reason, all copies of the Software must be 
immediately returned to Acronis, and the Original Purchaser shall be liable to Acronis for any 
and all damages suffered as a result of the violation or default. 

ENTIRE RISK 
THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE IS WITH 
YOU THE PURCHASER. ACRONIS DOES NOT WARRANT THAT THE SOFTWARE OR ITS 
FUNCTIONS WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF THE 
SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE OR THAT ANY DEFECTS WILL BE 
CORRECTED. NO LIABILITY FOR CONSEQUENTIAL DAMAGES - IN NO EVENT SHALL 
ACRONIS OR ITS VENDORS BE LIABLE FOR ANY DAMAGES WHATSOEVER (INCLUDING, 
WITHOUT LIMITATION, DAMAGES FOR THE LOSS OF BUSINESS PROFITS, BUSINESS 
INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS) 
ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE, EVEN IF ACRONIS HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
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Chapter 1. Introduction. General information 

1.1 Acronis True Image Enterprise Server - complete solution for 
corporate users 

Acronis True Image Enterprise Server creates an exact disk image of your live 
server for a complete backup, providing the most comprehensive and cost-effective 
server protection solution. 

The disk image file includes all of the server disk data, including the operating 
system, programs, databases, configuration files, preferences, updates, security 
patches, and the like. After a fatal failure, you can restore the complete server drive 
contents to a known, working state or simply replace lost or corrupted files and 
folders. 

Based on the exclusive Acronis Drive Snapshot technology, Acronis True Image 
Enterprise Server creates live server disk image without shutting down a server and 
interrupting server operations. 

With the Acronis True Image Management Console, you can manage image archives 
creation both locally and remotely, irrespective of the location of the server you 
want to image. 

Acronis True Image Storage Server provides disk image creation on the tape drives 
connected to workstations and servers, where the Storage Server component has 
been installed. 

Fastest recovery 

Acronis True Image Enterprise Server dramatically reduces server and workstations 
downtime in your network. Unlike traditional file-by-file backup solutions, Acronis 
True Image Enterprise Server disk imaging approach provides you with the fastest, 
bare-metal server recovery without time-consuming software reinstallations and 
reconfigurations. 

Rapid ROI 

Is server downtime costing you thousands dollars an hour? Acronis True Image 
Enterprise Server dramatically reduces IT costs by providing an easy, fast, and 
reliable way to return your server to its original state in minutes or to restore lost or 
damaged files and folders. 
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Disk cloning and new disk deployment 

Acronis True Image Enterprise Server can be used to clone an image onto multiple 
servers. For example, let’s say a company purchased several servers and needs the 
same environment on each of them. Traditionally, the IT manager would install the 
operating system and all programs on each system, then configure the systems one 
at a time. Acronis True Image simplifies the process and saves time by creating a 
disk image of the first system. That image is then deployed onto the multiple 
servers. 

If you need to upgrade the server hard disk drive, Acronis True Image Enterprise 
Server reduces the task to a few mouse clicks by duplicating an exact copy of the 
old disk onto a new one, adjusting partitions sizes automatically to fit the new hard 
disk.  

1.2 Acronis True Image Enterprise Server key features 

Acronis True Image Enterprise Server offers the following features: 

 Image creation and restoration without reboot in most cases 

 Acronis True Image Enterprise Server images only the sectors that contain data, 
so images are created in just a few minutes 

 Acronis True Image Enterprise Server supports a variety of IDE, SCSI, USB, 
FireWire, and PC Card (formerly PCMCIA) storage media 

 Support for all hard disks, regardless of capacity 

 Network tape drives support for images saving and restoring  

 Full and incremental backups 

 Support of basic and dynamic disk imaging 

 Scheduled and periodical image creation 

 Remote images creation 

 Remote images restoring 

 Remote images checking 

 Remote scheduling of reserve image creation 

 Scheduling group tasks for remote computers 

 SCSI tape support 

 Command-line mode support 

 Logs viewing 

 Databases work suspension for an image creation period 

 Automatic or manual hard disk installation 

 Partition relocation and resizing 
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 Support for all Windows and Linux file systems, including FAT 16, FAT 32, NTFS, 
Linux Ext2/Ext3, ReiserFS, Reiser4, Linux Swap, JFS, XFS; sector-based support 
for other operating systems  

 User-friendly Windows XP-like interface with full mouse support 

 Comprehensive wizards simplify even the most complex operations 

 Ability to create a hidden partition (the Acronis Secure Zone) where the IT 
manager can store a copy of the disk image 

 Acronis Secure Zone remote managing 

 Control of data compression levels, image volume splitting and password 
protection 

 The ability to clone a disk drive so that multiple systems will have the exact 
same base disk drive configuration and software 

 Adjustment of a priority for process of image creation 

 Exception of paging/hibernate files from images in order to decrease the image 
file size 

 Partition/disk image integrity check before restoration 

 Partition/disk file system integrity check after restoration 

 E-mail or Windows Popup notification when backup is finished or if backup fails 

 The ability to migrate data from one drive to another 

 The ability to take an existing drive and prepare it to be redeployed as a new 
system drive or a data drive 

 The ability to recover an entire disk, a specific partition, an individual folder or 
an individual file  

 The ability to change a partition type, file system, size and location during 
recovery 

 The ability to create a bootable diskette or CD as a system rescue disk  

 OS-independent operation of Acronis True Image Enterprise Server from the 
bootable diskette or CD. 

 Includes plug-in for Bart PE utility. 

1.3 Acronis True Image Enterprise Server Architecture 

Acronis True Image Enterprise Server includes the following components: 

1. Acronis True Image Management Console — lets you install and manage 
the Acronis True Image Agent on a remote machine: creates partition/disk backups, 
schedules data backup, etc. 

2. Acronis License Server is designed to manage Acronis enterprise product 
licenses from a single location 

 



Introduction  

 

10 Copyright © Acronis, Inc., 2000-2005 

3. Acronis True Image Agent — installs on a remote system to enable access 
from Acronis True Image Management Console 

4. Acronis True Image Storage Server — allows you to get a remote access to 
data storage devices (especially tape drives) connected to the PC (workstation or 
server) with the Acronis True Image Storage Server component installed 

5. Acronis True Image (local console) — creates backup copies of partitions/disks 
and restores data from them if needed 

6. Acronis Bootable Rescue Media Builder — creates bootable discs (or 
diskettes) to enable partition/disk data restoration, even if the operating system is 
corrupted. 

Also Acronis True Image Enterprise Server includes the utilities for work in a 
command-line mode and for scripts creation and performance. 

1.4 Supported security standards 

Acronis True Image Enterprise Server fully supports all security standards used in 
both local and server versions of the Windows Operating System. 

For more information on setting up security parameters for Acronis True Image 
Enterprise Server in your enterprise network, read section 2.7 of this Guide. 

1.5 Software usage terms and conditions 

The conditions for Acronis True Image Enterprise Server software usage are 
described in the «License Agreement» (page 3 of this manual). A set of unique 
serial keys, supplied with the product, is the confirmation of the legal purchase and 
use of the suite. 

Under current legislation, the «License Agreement» is considered a contract 
between the user and software vendor. The contract is a legal document and its 
violation may result in legal action. 

Illegal use and/or distribution of this software will be prosecuted.
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Chapter 2. Installation and running 

2.1 System requirements 

Acronis True Image Enterprise Server requires the following hardware: 

 Pentium processor or higher 

 128 Mb RAM 

 FDD or CD-RW drive for bootable media creating 

 Mouse (recommended). 

2.2 Supported operating systems 

Acronis True Image: 

 Windows NT SP6/2000/XP 

 Windows NT 4.0 Server SP6/2000 Server/2000 Advanced Server/2003 Server 

Acronis True Image Agent: 

 Windows 98/Me 

 Windows NT SP6/2000/XP 

 Windows NT 4.0 Server SP6/2000 Server/2000 Advanced Server/2003 Server 

Acronis True Image Storage Server: 

 Windows NT SP6/2000/XP 

 Windows NT 4.0 Server SP6/2000 Server/2000 Advanced Server/2003 Server 

Acronis True Image Management Console: 

 Windows 98/Me 

 Windows NT SP6/2000/XP 

 Windows NT 4.0 Server SP6/2000 Server/2000 Advanced Server/2003 Server 

 

Acronis Components remote installation and connection is not supported in MS Windows XP 
Home Edition through this operating system's limitations. 

For more information about Acronis components remote installation see section 3.2 
of this manual. 
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2.3 Supported file systems and media 

2.3.1 Supported file systems 

Acronis True Image Enterprise Server supports the following file systems: 

 FAT16/32 

 NTFS 

 Ext2/Ext3 

 ReiserFS 

 Reiser4 

 Linux SWAP 

 XFS 

 JFS 

If a file system is not supported or is corrupted, Acronis True Image Enterprise 
Server can copy data using a sector-by-sector approach. 

 

For XFS, JFS and Reiser4 file systems partition resizing feature is not supported. 

2.3.2 Supported media 

Acronis True Image Enterprise Server supports any local, network and removable 
media, including: 

 Local and networked hard drives 

 Tape drives  

 Tape drives connected to the remote PC 

 IDE and SCSI RAID controllers of any level 

 CD-R/RW drives 

 DVD+R/RW, DVD-RW (DVD burning software required) 

 USB and FireWire (IEEE-1394) storage devices 

 Magneto-optical media, Iomega ZIP/Jaz, etc. 

2.4 License policy 

Acronis True Image Enterprise Server licensing is based on the number of servers 
on which Acronis True Image Agent and/or Acronis True Image (local console) are 
to be installed. In other words, you need one license for each server you are going 
to backup, whether you will control it on-site (with local console) or remotely (using 
Acronis True Image Agent), or use both ways of control. The number of Acronis 
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True Image Management Console, Acronis License Server and Acronis True Image 
Storage Server installations is not counted.  

To manage the corporate license information, you must install Acronis License 
Server and import the license data (serial keys) bundled with your Acronis True 
Image Enterprise Server copy (see 2.6 “Using License Server Management Tool”). If 
you buy more licenses, import the additional serial keys as well.  

Acronis License Server can import multiple serial numbers from a .txt file, saving 
you from time-taking procedure of typing in serial keys.  

2.5 Acronis True Image Enterprise Server installation  

2.5.1 Installing Acronis True Image Enterprise Server components  

To install Acronis True Image Enterprise Server components: 

 run the Acronis True Image Enterprise Server setup file 

 in the Install Menu, select the program to install: Acronis True Image 
Management Console, Acronis License Server, Acronis True Image Agent, 
Acronis True Image Storage Server or Acronis True Image Enterprise Server 
(here: a standalone component for a local server, called in this guide ‘local 
console’ or ‘Acronis True Image’) 

 follow the Install Wizard instructions on the screen.  

It is recommended that you install Acronis License Server first. You will not be able 
to install Acronis True Image Agent or Acronis True Image Enterprise Server onto 
the current or remote computer until you import the serial key into Acronis License 
Server (see 2.6 “Using License Server Management Tool”). 

When the Specify License Server window appears, specify the License Server for 
license validation. It can be found automatically on the local network or specified 
manually (type in the DNS-name of the computer with Acronis License Server 
installed, or its IP-address). 
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Acronis True Image Enterprise Server Install Menu Window 

 

When installing a component onto Windows 9x-based system, you may be prompted to install 
Microsoft Installer utility (the later Windows operating systems come with this utility built-in). 
Choose Yes to install Microsoft Installer, included into Acronis True Image Enterprise Server
pack. 

For Acronis True Image Enterprise Server and Acronis True Image Agent, Typical, 
Custom and Complete installation is available. Having pressed Custom, you can 
choose to install, besides the main component, Rescue Media Builder and Bart 
PE plug-in for Acronis True Image Enterprise Server, or Acronis Secure Zone 
manager for Acronis True Image Agent.  

With Rescue Media Builder you can create bootable rescue disks (see 12.2).  

Well-known Bart PE utility is used to boot Windows-like environment from CD. 
Applications are installed into Bart PE in the form of plug-ins. Choosing Bart PE 
plug-in installation (disabled by default) provides the ability to include Acronis True 
Image Enterprise Server into Bart PE plug-in tab. The plug-in files will be placed into 
the component installation folder along with other program files.  

Acronis Secure Zone manager lets you create, delete and resize a special hidden 
partition for storing disk and partition images (see 3.7). 

When installing Acronis True Image Agent onto Windows 98/Me-based system, you 
must provide username and password, required for Acronis True Image 
Management Console remote access to this system. More about access control in 
2.7.  
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When installed, Acronis True Image (local console) creates a new device in the Device 
Manager list (Control Panel → System → Hardware → Device Manager → Acronis
Devices → Acronis TrueImage Backup Archive Explorer). Do not disable or uninstall 
this device, as it is necessary for connecting images as virtual disks (see Chapter 7 “Browsing 
and restoring particular files” of this manual).  

2.5.2 Extracting Acronis True Image Enterprise Server components  

You may want to save setup (.msi) files for each Acronis True Image Enterprise 
Server component separately on a local or network drive. Then you will be able to 
install the components in the command-line mode using msiexec.exe utility. It also 
will help to modify or recover the existing component installation.  

To save a setup file: 

 run the Acronis True Image Enterprise Server setup file; 

 in the Install Menu, right-click on the component name and select Extract; 

 select location for setup file and click Save. 

2.6 Using License Server Management Tool 

Acronis License Server includes special command-line utility 
LicenseServerCmdLine.exe for managing license information. Using this tool, 
you can look through and add information on available licenses.  

After Acronis License Server installation LicenseServerCmdLine.exe is located in 
the installation folder, e. g. C:\Program Files\Acronis\LicenseServer. 

LicenseServerCmdLine.exe uses the following syntax: 

LicenseServerCmdLine [option] [parameter1] [parameter2] 

LicenseServerCmdLine.exe supported options and usage: 

--list 

Displays the list of the License servers available in the local network. 

--status [server name or server IP-address] 

Displays specified License Server status.  

--import [server name] [serial key] 

Adds information about new license (new serial key). You can specify multiple serial 
numbers (space separated).  

--import-file [server name] [filename] 
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Imports license serial keys from .txt file. 

--help 

Shows help information. 

2.7 Setting up security parameters for Acronis True Image Enterprise 
Server 

2.7.1 Usernames and passwords 

Acronis True Image Enterprise Server fully supports all security standards used in 
Windows: 

1. If a remote PC has Windows NT SP6/2000/XP OS installed, the Acronis True 
Image Agent can be accessed according to the security policy set up in the local 
network. To have remote access to Acronis True Image Agent, the user must be a 
member of the Administrators or Backup operators group on this computer. 

 

It is highly recommended that you create an administrator’s or backup operator’s accounts with 
the same username and password on all networked computers for remote access to the Acronis
True Image Agent. 

2. If a remote PC has Windows 98/Me installed without its own security system, you 
will need to provide a username and password during installation of the Acronis 
True Image Agent that will be used by Acronis True Image Management Console. 

2.7.2 Firewall setup 
Acronis True Image Enterprise Server uses the following ports and IP addresses for 
remote operation: 

• server (Acronis True Image Agent) UDP port: 9876 

• server (Acronis True Image Agent) TCP port: 9876, if busy 
chose port at random 

• client (Acronis True Image Management Console) UDP port: 
9877, if busy chose port at random 

• IPv4 multicast address: 239.255.219.45 

• IPv6 multicast address: FF05::fAA5:741E. 

You might have to set the appropriate firewall access options. Options for the 
Windows Firewall, included in Windows XP Service Pack 2, are set automatically 
during Acronis True Image Enterprise Server components installation. However, 
make sure that the option File and Printer Sharing in the Control panel → 
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Windows Firewall → Exceptions is enabled on the remote computer, before the 
remote operation starts. 

2.7 Running Acronis True Image Enterprise Server components 

2.7.1 Running Acronis True Image 

To run Acronis True Image on a local computer, select Start → Programs → 
Acronis → True Image → Acronis True Image Enterprise Server or click on 
the appropriate shortcut on the desktop. 

2.7.2 Running Acronis True Image Management Console 

To run Acronis True Image Management Console, select Start → Programs 
→ Acronis → True Image → Acronis True Image Management Console. 

2.8 Removing Acronis True Image Enterprise Server components 

You can remove any Acronis True Image Enterprise Server component separately by 
selecting Control panel → Add or remove programs → <The component 
name> → Remove. Then follow the instructions on the screen. 
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Chapter 3. Using Acronis True Image 
Management Console 

3.1 General information 

Acronis True Image Management Console is the primary tool for managing data 
backups on remote computers with the Acronis True Image Agent installed. 

Acronis True Image Management Console enables you to perform the following: 

 Connect to a remote PC that has the Acronis True Image Agent installed 

 Create partition/disk images to be able to quickly restore OS and user data in 
case of any software or hardware failures 

 Restore remote partition/disk (except system partitions) 

 Manage Acronis Secure Zone on a remote PC 

 Setup notifications receiving about results of backup operations on the remote 
computer 

 Stop and Launch Windows NT SP6/2000/XP services during an image file 
creation  

 Check image integrity independently wherever they reside, be it local, network 
or removable media 

 Schedule backup operations 

 Schedule group tasks for remote PCs 

 Install, update or remove Acronis True Image Enterprise Server components on 
remote PCs (requires appropriate access rights) 

 Browse logs of all problems arisen during Acronis True Image Agent operation 

 Create bootable CD or diskettes to be able to restore images even if OS is 
corrupted 
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Acronis True Image Management Console main window  

3.2 Installing Acronis components onto a remote machine  

Acronis True Image Management Console allows you to install Acronis components 
onto remote computers, connected to the corporate network. 

Using the Acronis True Image Management Console you can install remotely: 

 Acronis License Server 

 Acronis True Image Agent 

 Acronis True Image 

 Acronis Storage Server 

To install any Acronis component to a remote machine using the Acronis True 
Image Management Console you will need administrator rights on the target 
machine. 

To install Acronis components: 

 Select the Install Acronis components item in the central part of Acronis 
True Image Management Console main window or a similar item on the Tools 
sidebar or the main menu 

 Select the installer location from the list (Registered Components, Search 
removable media or Specify location) 

 Select the Acronis component and specify the component features you want to 
install 

 If the Specify License Server window appears, specify the License Server for 
license validation. It can be found automatically on the local network or specified 
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manually (type in the DNS-name of the computer with Acronis License Server 
installed, or its IP-address) 

 Specify network name or IP address of the machine on which Acronis 
component is to be installed. You can also select a PC from the list of available 
using Browse… button. At that point you will have to provide administrator 
username and password 

 The Acronis component then will be installed to the remote PC you specified 

 If you checked Reboot the remote computer box during the Acronis True 
Image Agent and Acronis True Image installation, the remote machine will 
reboot. Otherwise you will see the corresponding message.  

 
Remote installation of Acronis True Image Agent 

 

You can remotely install Acronis components only onto machines working under Windows NT
SP6/2000/XP (including server versions). Windows 98/Me machines will require local 
installation of Acronis True Image Agent.  

 

If the remote PC runs under Windows XP, make sure the option Use simple file sharing in 
the Control panel → Folder options → View is disabled before the remote installation 
starts. 

 

If the remote PC runs under Windows XP with Service Pack 2 installed, make sure that the 
option File and Printer Sharing in the Control panel → Windows Firewall → 
Exceptions is enabled before the remote installation starts. 

3.3 Connecting to a remote PC 

After you install Acronis True Image Agent on a remote PC, you will see it in the list 
of machines to which you can connect from the Acronis True Image Management 
Console. Use View → Computers to access this list. 

To establish a remote connection, you will need to: 

 Select New connection in the Remote management sidebar section of 
Acronis True Image Management Console main window or the associated menu 
or toolbar items. You can also establish a connection using context menu 
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invoked by right-clicking the desired machine name in the View → Computers 
list 

 Specify PC network name or select a PC using Browse… button 

 Enter administrator or backup operator username and password 

 After connection is established, in the central part of Acronis True Image 
Management Console main window you will see a list of operations available: 

 
Main window of Acronis True Image Management Console when connected to a 

remote PC 

 

If Windows 98/Me is running on a remote PC, while the PC user has not logged in the network,
tasks, requiring network access, cannot be selected for this PC. For example, it is not possible 
to create the PC disk image on a network drive. 

After you perform all necessary operations on the remote PC, click Disconnect in 
the Remote management sidebar section. 

3.4 Creating partition/disk images on a remote PC 

After establishing a connection with a remote PC, you can create images of any PC 
partitions/disks. 

To perform this operation select Create image in the main window. 
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Create Image Wizard Window 

This is described in detail in Chapter 5 «Creating a partition (disk) image». 

You can keep an image file on the remote PC, any other networked PC, or on 
removable media. 

 

Install Acronis True Image Storage Server component if you are to create backup image on a 
tape drive, connected to any networked (remote) PC. 

Attention!!! When creating an image using Storage Server, always choose Incremental
image creation, even if you need a full image. Otherwise other computers images, stored on 
this tape, will be erased. 

3.5 Checking image integrity 
Having created an image, you can use Acronis True Image Agent to check its 
integrity. Here is the procedure: 

1. Connect to a remote PC with Acronis True Image Agent installed 

2. Run Check Image Wizard by selecting the respective item in the main 
application window 

3. Follow Wizard instructions. 

For more information on checking image integrity, see section 12.1 of this Guide. 

3.6 Remote image restoring 

With Acronis True Image Management Console you can restore partitions (logical 
drives) from images onto remote PCs. 

For more information on restoring a disk (partition) from image files, see Chapter 6 
of this guide. 

 

Attention! Using Acronis True Image Management Console you can remotely restore any disk 
partition, except system partition. 
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3.7 Acronis Secure Zone remote managing 
With Acronis True Image Management Console you can operate (create, resize, 
delete) Acronis Secure Zone on a remote PC; 

Acronis Secure Zone is a special hidden partition for storing disk and partition 
images. Usual applications can’t access it for image security purposes. It can be 
used to store both images, and data, considering its properties. 

To manage Acronis Secure Zone on a remote PC you need: 

 Connect to remote PC 

 Select Manage Acronis Secure Zone item and run Manage Acronis Secure 
Zone Wizard. 

Full information on operations with Acronis Secure Zone you can find in the section 
4.2 of this guide. 

3.8 Scheduling image creation 

Using Acronis True Image Agent installed on a remote machine, you can schedule 
and edit backup tasks on it.  

You will need to: 

 Establish connection to the remote PC using Acronis True Image Management 
Console 

 Select View → Active tasks in the main menu. You will see a new window with 
all scheduled backup tasks. If no tasks have been created, the list will be empty 

 Click Schedule Task in the Active Tasks section to invoke Schedule Task 
Wizard 

 Follow Wizard instructions to create and set up new partition/disk backup task 

You can edit newly created tasks later: change partitions to backup or time to run 
the task at. 

For more information on scheduling partition/disk image creation see Chapter 10 
«Scheduling» of this Guide. 

3.9 Scheduling group backup tasks 

You can create a backup task for several remote computers at once. 

 Select New Group Task from Remote management sidebar section of 
Acronis True Image Management Console main window. Create Group Task 
Wizard window appears to guide you through the task creation procedure. 

 Form a group for the current task: check computers in the list of remote 
computers. 

 Select disks/partitions to backup. You can select any combination of hard disks 
(by number, according to Windows numeration) and partitions (by letter); or All 
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hard disks. This setting is applied to every computer in the group, so having a 
standard (similar) disks/partitions layout on remote computers would be a plus. 

 
Select disk/partitions to image 

 Specify a path to backup image files. To place every image on its local 
computer, input Local path or select Acronis Secure Zone, if there is such a 
zone on every remote computer. For more information about creating and 
managing Acronis Secure Zone see 3.7 «Acronis Secure Zone remote 
managing». To place images on network, check Network path and select the 
target folder. You should also provide image file name, unless the image is 
targeted to Acronis Secure Zone. 

 Specify a usual set of backup options: image mode (full or incremental), image 
password, image file splitting, compression level and comments.  

 Select when you would like this task to be started. The scheduling procedure is 
almost the same for individual and group tasks, see Chapter 10 «Scheduling» for 
details. 

 If on any reason (traffic limitation, for example) you do not want the task to 
start on all computers simultaneously, set Start time shift parameter. The task 
will start on all computers in turn, with time shift you specify. As soon as you 
select time shift, the resulting task start time for the first and the last computer 
will be displayed. 

 Now enter the username and password. It is supposed, that accounts with same 
username and password exist on all computers of the group (computers, 
running Windows 98/Me, must get this username/password during Acronis True 
Image Agent installation). In this case, the task will be automatically distributed 
to computers. Otherwise, you will be asked for username/password to every 
computer in process of distribution. 

 At the final step, group task script is displayed. Until now, you may click Back to 
make changes in the created task.  
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Group task script 

 After you click Proceed, Acronis True Image Management Console connects to 
every computer of the group in turn to distribute the task. If a remote computer 
is inaccessible (shut down, for example), a dialog box appears. In this box, 
choose Ignore to exclude the computer from the group or Cancel to cancel the 
entire task. 

 When distribution is completed, you may connect to any computer to see its 
individual task, based on the group task you successfully created. 

You can see the group task list, edit or delete group tasks, using Edit Group Task 
and Delete Group Task options. When editing or deleting a group task, enter the 
same username and password you entered when created the task. 

3.10 Browsing logs 
Using Acronis True Image Agent on a remote machine you can view results of 
image creation operations, both real-time and scheduled. 

This is possible thanks to logs that can be accessed by clicking Show log in the 
main window after connection to a desired remote PC is established.  
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Log Viewer window 

The log window has two panels: log entries are listed on the left while selected log 
content is on the right. 

The left panel can contain up to 50 lines. If there are more, you can browse the list 
using Prev message and Next message buttons. 

To delete an obsolete log entry, select it and click Delete selected log entry. 

If any operation stage finished with an error, this entry will be marked with a red 
circle with a white cross inside. 

The right panel contains the list of performed operations that can be flexibly 
adjusted for your taste. You can filter messages, columns or sort operations by any 
column. 

To sort messages by a column click its header (click again to reverse order) or click 
Arrange icons by… button and select the desired column. 

To filter columns, right-click column header line or left-click Choose Details... 
button and select columns to view or deselect those to filter out. 

Three buttons to the left control message output: the one with a white cross in the 
red circle shows/hides error messages, the one with an exclamation mark in the 
yellow triangle shows/hides warnings, while the button with an "i" in the blue circle 
controls information messages. 

You can also adjust column width by dragging borders with mouse. 

3.11 Operation results notification 



 Using Acronis True Image Management Console 

 

Copyright © Acronis, Inc., 2000-2005 27

 

Sometimes the backup procedure on a remote PC can require 30 minutes or more. 
Acronis True Image Enterprise Server can notify you about backup results, when it’s 
finished, by using the WinPopup service or by sending you an email. 

To set up Email notification, click Remote Computer Options in the main 
window. Options window will appear. Select Email from the tree menu. 

To set up WinPopup notification, click Remote Computer Options in the main 
window. Options window will appear. Select Windows Messenger (WinPopup) 
from the tree menu. 

3.12 Stopping and launching Windows NT SP6/2000/XP services 
during an image file creation 

A number of services in Windows, including mail and database servers, such as MS 
Exchange or MS SQL Server, work with a plenty of constantly open files. Therefore 
many system administrators prefer to end working process of the given services at 
the backup moment (image file creation). 

To solve this problem you have to create the batch files. Batch files help you to stop 
the chosen services and then automatically launch them again directly in the Acronis 
True Image Enterprise Server. 

For more information on stopping and launching services see section 5.11 of this 
Guide. 

3.13 Updating Acronis True Image Agent 
Acronis True Image Management Console enables you to update Acronis True 
Image Agent on a remote PC. 

To do this, connect to the desired PC and select Update Acronis remote agent in 
the main window and follow Wizard instructions. 

This section allows you to re-install Acronis True Image Agent from selected PC. 

To update and re-install Acronis True Image Agent, you will need to connect to it 
with administrator rights. 

3.14 Creating bootable media using Acronis True Image Management 
Console 

Acronis True Image Management Console also enables you to create bootable CDs 
or diskettes that can be used to restore images even if the OS is corrupted due to 
software or hardware failures. 

To create bootable media: 

 Run Acronis True Image Management Console 

 Select Create bootable rescue media from the Tools menu or the sidebar, or 
click the appropriate button on the toolbar  
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 This will invoke Acronis Bootable Rescue Media Builder. In the process you will 
be prompted to select the full or safe loader version. The latter does not include 
USB, PC Card (PCMCIA), or SCSI drivers and is meant for situations when the 
full version does not work 

 Having created a bootable disc or diskettes, identify it and keep in a safe place. 

 
Acronis Bootable Rescue Media Builder 
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Chapter 4. Running Acronis True Image 
(locale console) 

4.1 Main program window 

The main program window contains the menu, the toolbar, the sidebar, the main 
area and the Tasks area. The main area contains operation icons, the sidebar 
features Tools and Help panels. 

 
The main program window 

Most of the operations are represented two or even three times in different window 
areas, providing several ways of their selection for more convenience. 

For example, you can execute the necessary operation by clicking its icon in the 
main area or by selecting the same item from the Operations or the Tools menu. 

The main window contains operation icons divided into two groups. 

The Task for Local Computer group contains disk image operations: 

Create Image – create a disk (partition) image. 

Restore Image – restore a disk (partition) from a previously created image. 

Disk Clone – transfer OS, applications and data from the old disk to the new one. 
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Add New Disk – add the new disk for data storage leaving OS and applications on 
the old one. 

The Tools group contains the following items: 

Explore Image – connect an image as a virtual drive. 

Unplug Image – disconnect connected virtual drive.  

Check Image – runs disk (partition) integrity checking procedure. 

Show Log – opens a window with logs. 

Manage Acronis Secure Zone – creates Acronis secure zone on a disk that is a 
special hidden partition for storing disk (partition) images. 

Activate Acronis Startup Recovery Manager – activates the boot restoration 
manager. 

Program menu 

The program menu line contains the Operations, View, Tools, and Help items. 

The Operations menu contains list of the available operations and scheduled tasks. 

The View menu contains items for managing the program window look: 

Toolbars – contains commands that control toolbar icons. 

Common Task Bar – enables/disables common task panel in the left area. 

Active Tasks – shows/hides scheduled tasks window. 

The Tools menu contains the following items: 

Manage Acronis Secure Zone – creates Acronis secure zone on a disk that is a 
special hidden partition for storing disk (partition) images. 

Activate Acronis Startup Recovery Manager – activates the boot restoration 
manager. 

Check Image – runs disk (partition) integrity checking procedure. 

Show Log – opens a window with logs. 

Create Bootable Rescue Media – runs bootable media creation procedure. 

Options – font and email/WinPopup notification settings 

The Help menu is used to invoke help and information about Acronis True Image 
Enterprise Server. 

Status bar 

In the bottom of the main window there is a status bar divided into two parts. The 
left part briefly describes the selected operation; the right one indicates image 
operations progress and results. 
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A double-click on the operation progress line opens the operation progress window. 
If you double-click on the operation results, you will see the logs window (see 
"Viewing logs"). 

Taskbar notification area icon 

During image creation operations a special indicator icon appears in the notification 
area (right part of the taskbar with the clocks). If you hover the cursor over it, you 
will see a tooltip indicating operation progress. This icon doesn’t depend on if the 
main program window is opened. It’s present for background execution of 
scheduled tasks as well. 

Disk and partition information 

You can change disk schemes and data representation in all schemes you see in 
various wizards. 

To the right over the scheme are three icons: Arrange Icons by, Choose Details 
and Display the properties of the selected item (also duplicated in the context 
menu invoked by double-clicking objects). 

To sort messages by a particular column, click its header (another click will switch 
order to the opposite) or Arrange Icons by button and select the column. 

To select columns to view right-click the headers line or left-click the Choose 
Details button. Then flag the columns you want to display. 

If you click the Display the properties of the selected item button, you will see 
the selected partition or disk properties window. 

This window contains two panels. The left one contains the properties tree, and the 
right describes the selected property in detail. The disk information includes its 
physical parameters (connection type, device type, size, etc.); partition information 
includes both physical (sectors, location, etc.), and logical (file system, free space, 
assigned letter, etc.) parameters. 

You can change columns width by dragging their borders with mouse. 

4.2 Acronis Secure Zone 

Acronis Secure Zone is a special hidden partition for storing disk and partition 
images. Usual applications can’t access it for image security purposes. 

If you create an Acronis Secure Zone, it will be listed along with all partitions 
available for image creation and restoration. 

The Acronis Secure Zone is primarily meant to be used with Acronis Startup 
Recovery Manager (see below). It is always available for image creation as long as 
there is space for it. If there’s not enough space, older images will be deleted to 
create space. 
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This means you can automatically create disk images easily on a schedule (see 
Chapter 10), not being bothered by zone overflow issues. 

 

The Acronis Secure Zone can still be filled completely when creating incremental images (see 
"Incremental images"). This happens because the program can't delete the first (full) image, 
as it might be required for restoration. Thus you should periodically check zone free space, 
when creating incremental images, to increase it, if necessary, or re-create images from the 
first. 

Acronis Secure Zone can be located on any local disk. It’s created at the expense of 
the unallocated space, if it’s available, or at the expense of partitions free space. A 
server can have only one Acronis Secure Zone. To create it on another disk, you 
must first delete the existing zone. 
When you click Manage Acronis Secure Zone in the menu, the program searches 
for such zone on all local drives. If a zone is found, the wizard will offer you to 
delete or resize it. If such zone is absent, you’ll be prompted to create it. 
Before you create the Acronis Secure Zone, estimate its size. To do this start image 
creation and select disks and partitions to image into the Acronis Secure Zone. At 
the compression level stage you will see estimated image size. Multiply this by 
about 1.5. If you plan to install additional applications or create incremental images, 
increase the zone size even more. 

4.2.1 Creating Acronis Secure Zone 
If there are several disks installed, select one to create Acronis Secure Zone. 
Select partitions, which space will be used to create Acronis Secure Zone. 

 

Enter the size of Acronis Secure Zone or drag the slider. 

In the next window you will see secure zone creation script containing the list of briefly 
described operations to be performed on partitions (disks). 
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After you click Proceed Acronis True Image Enterprise Server will start creating the 
Acronis Secure Zone. Progress will be reflected in the opened window. If needed, 
you can stop zone creation by clicking Cancel. However, the script will be cancelled 
only after the current operation is finished. 

Acronis Secure Zone creation might take several minutes or more. Please, wait until 
the whole procedure is finished. 

4.2.2 Resizing Acronis Secure Zone 

When prompted by the wizard, select Manage Acronis Secure Zone. 

Then select to increase or reduce the Acronis Secure Zone. You might need to 
increase it to provide more space for images. The opposite situation might arise if 
either partition lacks free space. 

After this select partitions, which free space will be used to increase Acronis Secure 
Zone or to add free space to after zone is reduced. 

Set the new size for Acronis Secure Zone. 

In the next window you will see an Acronis Secure Zone resize script containing a list of 
briefly described operations to be performed on partitions (disks). 

After you click Proceed Acronis True Image Enterprise Server will start resizing the 
secure zone. Progress will be reflected in the opened window. If needed, you can 
stop zone creation by clicking Cancel. However, the script will be cancelled only 
after the current operation is finished. 

Secure zone resizing might take several minutes or more. Please, wait until the 
whole procedure is finished. 

4.2.3 Deleting the images in Acronis Secure Zone 

The images saved to Acronis Secure Zone are deleted automatically if required. 
Acronis True Image Enterprise Server uses the following scheme to clean up Acronis 
Secure Zone: 

• If there is not enough free space in Acronis Secure Zone to create an image, 
then Acronis True Image Enterprise Server deletes the most old full image with 
all subsequent incremental backup images. 

• If there is only one full image (with subsequent incremental backup images) left 
and full backup is in progress, then this only full image (with subsequent 
incremental backup images) is deleted. 

• Otherwise (only one full image left, and incremental backup is in progress) then 
you will get out of space error. In this case you will have to either create full 
image or increase the Acronis Secure Zone size. 

You can always check how much free space left in Acronis Secure Zone on the 
second page of the Manage Acronis Secure Zone wizard. 
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4.2.4 Deleting Acronis Secure Zone 

When prompted by the wizard, select Remove Acronis Secure Zone. 

Select partitions to add space freed from Acronis Secure Zone. 

 

In the next window you will see an Acronis Secure Zone deletion script containing a list 
of briefly described operations to be performed on partitions (disks). 

After you click Proceed Acronis True Image Enterprise Server will start deleting the 
Acronis Secure Zone. Progress will be reflected in the opened window. If needed, 
you can stop zone creation by clicking Cancel. However, the script will be cancelled 
only after the current operation is finished. 

Acronis Secure Zone deletion might take several minutes or more. Please, wait until 
the whole procedure is finished. 

 

Acronis Secure Zone deletion will automatically disable Acronis Startup Recovery Manager if 
it's activated and destroy all images stored in the zone. 

 

Acronis Secure Zone can be located on basic disks only. (A basic disk is a physical disk 
without any dynamic disks.) If a server has only dynamic disks, you won’t be able to create 
the Acronis Secure Zone. 

 

Upgrading a disk with an Acronis Secure Zone from basic to dynamic will prevent access to 
the Acronis Secure Zone and disable the Acronis Startup Recovery Manager. Therefore, we 
suggest that you delete the Acronis Secure Zone before performing such an operation. 
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4.3 Acronis Startup Recovery Manager 

Acronis True Image Enterprise Server provides Acronis Startup Recovery Manager 
that enables to run the program without loading the operating system. This feature 
is useful if Windows doesn't load for some reasons. Using this manager, you can run 
Acronis True Image Enterprise Server standalone to restore damaged partitions 
from images. 

To use Acronis Startup Recovery Manager (it must be activated), turn on your 
server and press F11, when you see the "Press F11 for Acronis Startup Recovery 
Manager" message. This will run a standalone version of Acronis True Image 
Enterprise Server that only slightly differs from the Windows version. For 
information on restoring damaged partitions see Chapter 6. 

 

Be careful! When you run Acronis True Image Enterprise Server using Acronis Startup 
Recovery Manager (before Windows has started) or from bootable rescue media (diskette or 
CD), drive letters might sometimes differ from Windows notation. 

To activate Acronis Startup Recovery Manager, click Activate Acronis Startup 
Recovery Manager. 

Acronis Startup Recovery Manager cannot be activated if Acronis Secure Zone is 
missing on the hard disk. If you have not created this Zone before, you will be 
prompted to do it (see section 4.2.1 above), then Acronis Startup Recovery Manager 
will be activated. Otherwise, Acronis Startup Recovery Manager will be activated 
immediately. 

 

When Acronis Startup Recovery Manager is activated it overwrites the Master Boot Record 
(MBR) with its own boot code. If you have any third party boot managers installed, then you 
will have to reactivate them after activating the Startup Recovery Manager. For Linux loaders 
(e.g. LiLo and GRUB) you might consider installing them to a Linux root (or boot) partition 
boot record instead of MBR before activating Acronis Startup Recovery Manager. 

4.4 Using dynamic disks and volumes 

Acronis True Image Enterprise Server works with dynamic disk images as easy as 
with basic disk images under Windows. However, as dynamic disks are organized 
differently than basic, physical disk drives, there are several issues that will impact 
how you store an image. 

You can not create an image of the entire dynamic disk, but only of one or more 
dynamic volumes. This is because a dynamic volume is located on several dynamic 
disks, so a partial backup would not create a usable image. 

The current version of the software is not capable of changing the size and file 
system of an image being restored to a dynamic volume. However, this is possible 
when you restore a dynamic volume to a basic disk partition. 
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When you create a dynamic volume image, its type information (simple, mirror, and 
the like) is lost, so the restoration is performed independently. In each case, the 
program stores and restores volume contents only. 

If a basic disk image is restored to a dynamic disk, it will destroy the dynamic disk’s 
contents. As a result, you will end up with a basic disk. 

You can also create and restore an image of a system partition stored on a dynamic 
disk.  

 

If Acronis True Image Enterprise Server runs from Acronis Startup Recovery Manager (before 
Windows has started) or from Bootable Rescue media, dynamic disks will be not accessible. 
To be able to restore a system partition, you must keep its image on a basic, network, or 
removable disk. 

4.5 Backing up to tape drive 

The current version of Acronis True Image Enterprise Server supports SCSI tape 
drives. It can store images on and restore them from tape, store large images to 
multiple tapes, and append incremental images on to a tape with the existing 
images. 

If you have a SCSI tape drive connected to your server, the list of devices available 
for image storage and restoration will be extended with a name corresponding to 
the drive type. 

Images are created on and restored from tapes in the same way as from other 
devices, with the following exceptions. 

1. If you are to use data tapes previously used by other programs, their contents 
will be cleared 

2. A new, full image can be stored on an empty tape only. If you use tapes that 
already contain data, their contents will be cleared and overwritten 

3. Incremental images can be appended to the tape containing the previous image, 
either full, or incremental 

4. You don't have to provide a filename to store an image on or restore it from a 
tape 

You might experience short pauses that are required to rewind the tape. 

 

Low-quality or old tape, as well as dirt on the magnetic head, might lead to pauses that can 
last up to several minutes long.  
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Chapter 5. Creating a partition (disk) image 

Disk (partition) image creation means backing up all data stored on your server. 
Having these images you can restore your server after failures and protect yourself 
from hard disk data losses. 

5.1 Selecting partitions 

In the Select Partitions to Image window you will see the hard disk layout of your 
server. Flag a partition to select it. Flag a whole disk to select all its partitions. You 
can select one or more hard disks or any combination of partitions and hard disks. 

 

Disk and partition layout 

Having selected partitions and/or disks, click Next. Note that this button is disabled 
as far as no partitions or disks are selected. 

5.2 Selecting image location 

Specify image file location on a storage device:  

• Acronis Secure Zone (see "Acronis Secure Zone"); 

• Hard disk; 

• Network disk; 

• Removable media drive, including tapes, CD-R/RW, DVD-RW, DVD+R/RW, 
Iomega Zip, Iomega Jaz, magneto-optical drives and so on. 



Restoring a disk (partition) from an image  

 

38 Copyright © Acronis, Inc., 2000-2005 

 

• Data storage device connected to the remote PC (a tape drive).  

 

You should have DVD UDF recording software installed for burning images on DVD disks, for 
example: Roxio DirectCD, Ahead InCD and other the same.  

 
Image location selection 

Select image location in the disk tree. In the File name field enter image file name. 
If you select Acronis Secure Zone or a tape, you don't have to provide a name. 

 

You can store several partitions and/or disks in a single file, but you can't append images to 
a file. 

 

The program can generate an unique filename. Just click Generate file name for a new 
file button at the right. 

You can create a disk (partition) image on the same disk (partition), if there is 
enough space for it, but do not leave it there. Better burn images to removable 
media, such as a CD, DVD or Zip disks, move to another hard disk or a network 
drive. The only reason to place an image on the same disk (partition) is creating a 
local, secondary image, used to restore damaged files. Remember, if your disk 
becomes physically damaged, an image stored on the same disk will be inaccessible. 

5.3 Selecting image mode 

At this point, you must decide if you need to create a complete or incremental 
partition (disk) image. 
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Image mode selection 

A full image contains all hard disk data, so it takes a lot of space. 

 

Acronis True Image Enterprise Server does not include swap file information (win386.swp 
under Windows 98/Me and pagefile.sys under Windows NT SP6/2000/XP), or hiberfil.sys (a 
file that keeps RAM contents when the computer goes into hibernation). This considerably 
reduces the image size and increases the speed of creating the image. 

An incremental image contains data only from sectors that changed after the 
previous full or incremental image was created, so it is usually smaller and takes 
less time to create.  

Therefore, if you create the first disk (partition) image, you should select the 
complete mode. If you already have a full image, it is recommended that you create 
incremental images. 

 

If you have defragmented your hard disk since the last full image, an incremental image
could be as large as the full image. 
Therefore we recommend you to make a defragmentation of a hard disk before the full 
image of the given disk will be created. 

5.3.1 Creating an incremental image 
To create an incremental disk/partition image, choose your original full disk image 
file in the directory tree of Image Archive Creation window and press Next 
button. 

If you already created the incremental backup, choose the last incremental 
disk/partition image in the directory tree. 

If image archive is stored on the removable media, e.g. CD, insert the last CD and 
then follow instructions of the Create Image Wizard. 



Restoring a disk (partition) from an image  

 

40 Copyright © Acronis, Inc., 2000-2005 

 

(Having a policy for creating full and incremental images is recommended. For 
example, you might consider creating a full image monthly and incremental images 
weekly.) 

If all image files are stored together, if doesn't matter which one you select, as the 
program will recognize them as a single image. If you stored these files on several 
removable discs, you must provide the latest image file, otherwise, restoration 
problems might occur. 

5.4 Selecting image file size 
At this step you can specify if the program should create a single file or split it into 
equal smaller images. 

If you select Automatic, Acronis True Image Enterprise Server will try to decide 
this for every particular case. If there's enough space on the selected disk, the 
program will create a single image file. 

If there's not enough space, Acronis True Image Enterprise Server will warn you 
and wait for your decision. You can try to free some additional space and continue 
or stop Acronis True Image Enterprise Server , free some space and re-execute the 
procedure. 

 

Image file size selection 

 

If you work with removable media, the size of a file of an image is set automatically only. 

 

FAT16 and FAT32 file systems have a limit for maximum file sizes. In particular, FAT16 limit 
is 2Gb, FAT32 limit – 4Gb. FAT32 is currently the most popular end user file system. At the 
same time, existing hard drives have capacities of 160Gb and above! Therefore, an image file 
might easily exceed this limit. In this case Acronis True Image Enterprise Server will 
automatically split image into several files. 
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If you need to automatically create an image on CD-R/RW, DVD-RW or DVD+R/RW 
media or a tape, Acronis True Image Enterprise Server will ask you to insert a new 
disc (tape), when the previous is full. 

You can also fix image file size by selecting Fixed size and entering the desired 
size or selecting it from the drop-down list. By default, the value is in bytes, but you 
can also use kilobytes and megabytes by adding needed units. 

 

You can also split image file into several volumes, when storing it on a hard drive as well, 
because in the future you'll be able to easily transfer these files onto CD-R/RW or DVD. And 
creating images directly on CD-R/RW, DVD-RW or DVD+R/RW might take considerably 
longer time then it would on a hard disk. 

5.5 Selecting data compression level 
On this step you must select the data compression level for image to be created. 

If you select None, all data will be transferred into an image file as they are, 
increasing the image size. The maximum compression might prolong image 
creation. 

 

Image data compression level selection 

The optimal data compression level depends on disk (partition) files types and can 
only be understood empirically. 

Usually, it is recommended to leave the switch in the Normal position. If you need 
to burn image to removable media, you can select Maximum compression. 
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5.6 Protecting images with passwords 

An archive file with a partition (disk) image can be protected with a password. If 
you think a partition (disk), you create an image of, shouldn’t be restored by 
anybody except you, enter a password and its confirmation into the text fields of 
the wizard page Image Archive Protection. A password should consist of at least 8 
symbols and contain both letters (in the upper and lower cases desirably), and 
numbers. (So it would be harder to hack it). 

 

Image password protection 

If you try to restore data from a password protected image, Acronis True Image 
Enterprise Server will ask for password in a special window allowing access only for 
authorized users. 

5.7 Providing comments 

On the wizard page Image Archive Comments you’ll be able to provide an archive file 
with any comment that may include any information on the server and its user, the 
hard disk, partition data, image creation time, and any peculiarities and conditions. 
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An image comment 

The more details are provided in the comment, the more assured you would be. 
If you don’t provide comments, you might mistake images and restore another 
system partition, for example. 

5.8 Image creation script 

In the next window, you will see disk(s) or partition(s) image creation script containing 
a list of briefly described operations to be performed. 

 
Image creation script 
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All operations of a partition (disk) image creation in an archive file are delayed in 
Acronis True Image Enterprise Server. A partition (disk) image creation script is 
created first, and then it’s executed. 

After you click Proceed, Acronis True Image Enterprise Server will start creating an 
image indicating the progress in the special window. You can stop this procedure by 
clicking Cancel. 

You can also close the progress window by clicking Hide. Image creation will 
continue, but you will be able to start another operation or close the main program 
window at all. In the latter case, the program will continue working in the 
background and will automatically close once the image is ready. If you prepare 
some more image creation operations, they'll be queued after the current. 

Icons of the current and queued operations will be shown in the bottom of the main 
program window in due time. 

 

If you are to burn an image to removable media, be sure to enumerate them, as you will 
have to insert them in order during the restoration. 

5.9 Selecting image creation priority 

After image creation is started, an icon appears in the System Tray (see section 
Chapter 1 of this Guide). 

Clicking this indicator you invoke the menu of image creation priority selection: 
Low, Normal or High. 

Normal is selected by default.  

5.10 Operation results notification 

Sometimes the backup procedure can require 30 minutes or more. Acronis True 
Image Enterprise Server can notify you about backup results, when it’s finished, by 
using the WinPopup service or by sending you an email. 

5.10.1 Email notification 

To set up Email notification, enable the respective parameter in Tools → Options 
→ Notification → E-mail: 
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At that point you will need to provide the email address to which you want the 
notification, as well as the outgoing SMTP server name. Your user name and 
password might also be needed if the SMTP server requires authentication. 

5.10.2 WinPopup notification 

To set up the WinPopup notification, enable the respective parameter in Tools → 
Options → Notification → WinPopup: 

 

At that point you will need to provide the network name of the PC to which you 
want the notification sent. 
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5.11 Stopping and launching the services in Windows NT SP6/2000/XP 
during an image file creation 
A number of services in Windows, including mail and database servers, such as MS 
Exchange or MS SQL Server, work with a plenty of constantly open files. Therefore 
many system administrators prefer to end working process of the given services at 
the backup moment (image file creation). 
To solve this problem you have to create the batch files. Batch files help you to stop 
the chosen services and then automatically launch them again directly in the Acronis 
True Image Enterprise Server. 
You will need to: 
• create a batch file in any text editor (for example, name it ‘stop_services.bat’) 

and write commands for stopping the necessary services in it, for example: 
net stop msexchangesa /y /y 
net stop “Microsoft Exchange Routing Engine” 

• create a batch file for subsequently launching of the suspended services (for 
example, name it ‘start_services.bat’): 

net start “Microsoft Exchange System Attendant” 
net start “Microsoft Exchange Event” 
net start “Microsoft Exchange IMAP4” 
net start “Microsoft Exchange MTA Stacks” 
net start “Microsoft Exchange POP3” 
net start “Microsoft Exchange Routing Engine” 

• Check Enable support parameter from Tools → Options → Database 
support  

• Select ‘stop_services.bat’ file from Before data capture command field 
• Select ‘start_services.bat’ file from After data capture command field 
After that you can start an image file process, not being afraid of data non-
consistency will arise. 

 
Database support settings
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Chapter 6. Restoring a disk (partition) from 
an image 

As mentioned above, Acronis True Image Enterprise Server can be run in several 
ways. However, disk restoration is always performed in a single way. 

We recommend you to restore disks from under Windows, using other ways only if 
it doesn’t load. 

Bootable media (e.g. a CD) you loaded from doesn’t keep you from using other CDs 
with images. Acronis True Image Enterprise Server is loaded entirely into the server 
RAM, so you can remove the bootable CD to insert an image disc. 

To restore a partition (disk) from an image, Acronis True Image Enterprise Server 
must obtain exclusive access to this partition (disk). This means no other 
applications can access it at that time. If you receive a message stating that the 
partition (disk) can not be blocked, close applications that use this partition (disk) 
and start over. If you can not determine which applications use the partition (disk), 
close them all. 

6.1 Selecting an image to restore from 

Find and select file containing an image of the required partition. The File Name 
field will reflect its name and the Next will become available. If this image is 
located in Acronis Secure Zone, select it to select the image on the next step. 

 
Image selection for restoration 
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If you are to restore an image from removable media, e.g. CD, first insert the latest burnt CD 
and then follow instructions of the Restore Image Wizard. 

If you provided a comment to the image, it would help you understand if you 
selected the right image. The comment is displayed in the right part of the window. 
Note that it can be seen without entering a password for a protected image. 
However, the contents of such image will still require a password. 

If an image was protected with a password, Acronis True Image Enterprise Server 
will ask for it. In this case the Next button will be disabled until you enter the right 
password. 

If you are to restore a disk (partition) from an incremental image, Acronis True 
Image Enterprise Server will suggest you to select one of successive incremental 
files by date/time of its creation. Thus, you can return the disk (partition) state to a 
certain moment, often called “a point of restore”. 

 
Image date selection 

 

To restore data from any incremental image, you must have all previous incremental images 
and the initial complete image. If any of successive images is missing, restoration is 
impossible. 

6.2 Checking image integrity before restoration 

Before an image is restored, Acronis True Image Enterprise Server can check its 
integrity. 

To do this, flag Yes, I want to verify the image archive on the Verify Archive 
Before the Restoring page of the image restoration wizard.  
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Checking image integrity before restoration 

This is disabled by default in Acronis True Image Enterprise Server. 

6.3 Selecting a partition to restore 

A single file might contain images of several partitions or even disks, as shown in 
the figure below. 

 
Select a disk or partition to restore 
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During a single restoration session you can restore several partitions or disks one by 
one by selecting one disk and setting its parameters first, and then repeating these 
actions for every partition or disk to be restored. 

Select the necessary disk or partition and click Next. 

6.4 Selecting a location to restore to 

As a rule you should restore image to the same partition that the image was created 
from. 

You can restore an image to another partition, but this is needed rather seldom. At 
that a partition should be of at least the same size as uncompressed image data. 

If you don’t have a serious reason to restore an image to another partition, restore 
it only to partition that was used to create this image. 

 
Select partition to restore image to 

 

All the data stored on the restored partition will be replaced by the image data, so be careful 
and watch for non-backed up data that you might need. 

6.5 Selecting partition type 
When restoring a partition you can change its type though it’s not required in most 
cases. To explain why you might need to do this, let’s imagine that both OS, and 
data were stored on the same primary partition on the damaged disk. You are 
forced to restore the partition from a backup to another hard disk with its own 
partitions and OS. 
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Select partition type 

If you need only the data, you don't have to create another primary partition. In 
this case, you can restore the partition as logical to access the data only. 

But if you are to restore a system partition, you should select the Primary type for 
it. Finally, if you want to load operating system from it, select Active as well. 

 

Selecting Active for a partition without an installed operating system might prevent your 
server from booting. 

6.6 Selecting a file system 

Though this is required rather seldom, you can change partition file system during 
its restoration. For partitions with FAT native file systems you can choose between 
FAT16 and FAT32. For partitions with Ext native file systems you can choose 
between Ext2 and Ext3. For partitions with other native file systems this option is 
not available. 
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Select a file system 

Let’s imagine you are to restore a partition from the old low-capacity FAT16 disk to 
a newer one. FAT16 wouldn’t be effective and might even be impossible to set on 
the high-capacity hard disk. The thing is that FAT16 supports partitions up to 4 Gb 
in size, so you won’t be able to restore a 4 Gb FAT16 partition to a partition that 
exceeds 4 Gb without changing the file system. 

It would be logical here to change the file system from FAT16 to FAT32 by setting 
the appropriate switch. 

But you must also have in mind that not all operating systems support FAT32. 
Windows 4.x doesn’t support FAT32 and won't be operable after you restore a 
partition and change its file system. These can be normally restored on a FAT16 
partition only. 

However, you can easily convert a FAT16 partition with newer OS into FAT32. 

6.7 Selecting restored partition size 

In some cases you might need to change partition configuration and size during the 
restoration. Acronis True Image Enterprise Server is flexible enough to do this. 

You can resize and relocate partition by dragging it or its borders with mouse or by 
entering corresponding values into the appropriate fields. 
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Select partition size and location 

 

You might need to resize and relocate a partition to redistribute the disk space between 
existing partitions. In this case you will have to restore the partition to be reduced first. 

These changes might be useful if you are to copy your hard disk to a new high-capacity one
by creating its image and restoring it to a new disk with larger partitions. This way of cloning 
is used if it is impossible to connect the second hard disk to the computer (for more details 
about cloning see 8.1). 

6.8 Assigning a letter to a partition 

Windows utilizes letters of Roman alphabet to identify disks and partitions 
automatically assigning them letters at loading. 

Under Windows NT SP6/2000/XP OS Acronis True Image Enterprise Server enables 
you to assign a restored partition (logical disk) any unused letter. To do this select 
Yes, I want to assign a logical drive letter to restored partition. If you don’t 
set this switch, no letters will be assigned to the restored partition making it hidden 
from OS. 
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Assign any unused letter to a partition 

You shouldn’t assign letters to partitions inaccessible for Windows anyway, i.e. to 
those different from FAT and NTFS. 

6.9 Checking file system integrity 
Having restored a disk/partition from an image under Windows NT SP6/2000/XP, 
Acronis True Image Enterprise Server can check the integrity of its file system. 

To do this, flag Yes, I want to check file system after the restoring on the 
Check File System After the Restoring page of the image restoration wizard. 

 
Checking file system integrity after restoration 
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This is disabled by default in Acronis True Image Enterprise Server. 

 

Only FAT16/32 and NTFS file systems integrity can be checked.  

6.10 Restoring several partitions at once 

You can restore several partitions during a single session. To do this select Yes, I 
want to restore another partition or hard disk drive in the Next Selection 
window and click Next. 

 

You can restore another partition during this operation 

After this you will see partition selection window again and will have to repeat 
actions mentioned above. 

If you want to restore only one disk (partition) or have already selected all partitions 
you need, don’t set this switch and click Next. 

6.11 Restoration script 

In the next window, you will see disk(s) or partition(s) image restoration script 
containing a list of briefly described operations to be performed. 
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Restoration scenario 

After you click Proceed, Acronis True Image Enterprise Server will start image 
restoration indicating the progress in the special window. If you click Cancel, no 
changes will be made to disk(s). 

You can also stop the procedure by clicking Cancel. But note that the partition that 
should have been restored from the image will be deleted and its space – 
unallocated. The same result you will get if the restoration is unsuccessful. To 
recover the “lost” partition, you will have to restore it from the image again. 

After the restoration is finished you will see a message about its results. 



 Browsing and restoring particular files 

 

Copyright © Acronis, Inc., 2000-2005 57

Chapter 7. Browsing and restoring particular 
files 

To browse and restore particular files Acronis True Image Enterprise Server can 
connect images as virtual drives thus enabling to access it as a usual drive. This 
means that: 

A new disk with its own letter will appear in the drives list; 

Using Windows Explorer and other file managers, you will be able to see image files 
as if they are located on a usual disk or partition; 

You’ll be able to find necessary files or folders to copy them from the virtual disk to 
the real one. 

The connected virtual drive will be read-only and you won’t be able to change 
anything within it. 

7.1 Connecting a virtual disk 

Use Explore Image in the Tools section to connect an image as a virtual disk and 
click Next in the first wizard window. 

7.1.1 Selecting an image 

In the next window specify image you want to open as a virtual disk. 

 
Select image to connect 
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If the selected image file is not protected by password, you will immediately see the 
image comment along with the list of stored partitions. If the file is protected by 
password, you will see only the comment. 

 

If you are to connect an incremental image, Acronis True Image Enterprise Server will 
suggest you to select one of successive incremental files by date/time of its creation. Thus, 
you can explore the partition state to a certain moment. 

To connect an incremental image, you must have all previous incremental images and the 
initial complete image. If any of successive images is missing, connecting is impossible. 

 

7.1.2 Selecting partitions to connect and letter assignment 

On this step you must select a partition to connect as a virtual disk. Note that you 
can’t connect the entire disk. 

 

Select partition to connect 
Besides, you can also select a letter to be assigned to the connected disk (from the 
Partition letter drop-down list.) 

In the next window you will see disk connection script containing a single operation. 
Click Proceed to connect the image as a virtual disk. 

After the disk is connected the program will run Windows Explorer showing its 
contents. 

Now you can easily copy any file (or folder) from the virtual disk to the real one 
using Windows Explorer or similar file manager. 
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7.2 Unplugging a virtual disk 

We recommend you to unplug a virtual disk after all necessary files and folders are 
copied. However, the virtual disk will disappear anyway after your server is turned 
off. 

To disconnect the virtual disk select Unplug. 

You can also unplug the disk by clicking Unplug Image in Acronis True Image 
Enterprise Server main window. 
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Chapter 8. Transferring system to a new disk 

8.1 General information 

Sooner or later any server user finds out his hard disk is too small. If you just don’t 
have space for data, you can add another disk just for data storage as described in 
the following chapter. 

But it can happen so that your hard disk can't provide enough space for the 
operating system and installed applications, preventing you from updating your 
software. In this case you have to transfer system to a newer higher-capacity hard 
disk. 

To transfer your system to a new disk, you must first install in into the server.  

 

If a server doesn’t have place for another hard disk, you can temporarily install it in the place 
of your CD-ROM. If it’s still impossible, you can clone a hard disk by creating its image and 
restoring it to a new hard disk with larger partitions. 

There are two transfer modes available: automatic and manual. 

In the automatic mode, you will just have to make several simple actions to transfer 
all the data, including partitions, folders and files, to a newer disk making it 
bootable (if the older was bootable as well). 

There will be only one difference between these disks – partitions on the newer disk 
will be larger. Everything else including the installed operating systems, data, disk 
labels, etc. will remain the same. 

 

Of course, this is the only result available in the automatic mode. The program can only 
duplicate the older disk layout to the new one. To obtain different result, you will have to 
answer additional questions about cloning parameters. 

The manual mode will provide more data transfer flexibility. 

1. You will be able to select the method of partitions and data transfer: 

• As is; 

• New disk space is proportionally distributed between the old disk partitions; 

• New disk space is distributed manually. 

2. You will also be able to select operations to perform on the old disk: 

• Leave partitions (and data!) on the old disk; 

• Remove all information from the old disk; 

• Create new partitions on the old disk (and remove all the older information.) 

 



 Transferring system to a new disk 

 

Copyright © Acronis, Inc., 2000-2005 61

 

On disk layouts, displayed by the program, damaged partitions are marked with a red circle 
with a white cross inside in the upper left corner. Before you start cloning you should check 
such disks for errors using corresponding OS tools. 

8.2 Security 

Note the following: if the power goes out or you accidentally press RESET during 
the transfer, the procedure will be incomplete and you will have to partition and 
format or clone the hard disk again. 

No data will be lost because the original disk is only being read (no partitions are 
changed or resized) until data transfer is completed. 

Nevertheless, we don’t recommend you to delete data from the old disk until you 
are sure it is correctly transferred to the new disk, server boots up from it, and all 
applications work. 

8.3 Executing transfers 

8.3.1 Selecting transfer mode 

You will see the Select transfer mode window just after the welcome window. 

 

Transfer mode selection 

We recommend using automatic mode as suitable for most cases. The manual 
mode can be helpful, if you need to change disk partition layout. 
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If the program finds two disks, one partitioned and another unpartitioned, it will 
automatically recognize the source and destination, so the next two steps will be 
bypassed. 

8.3.2 Selecting source disk 
If the program finds several partitioned disks, it will ask you what is the source (i.e. 
the older data disk). 

 

You can determine the source and destination using the information provided in this 
window (disk number, capacity, label, partition and file system information). 

8.3.3 Selecting destination disk 
After you select the source disk, you have to select the destination to clone to. 
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The previously selected source becomes grayed-out and disabled for selection. 

 

If either disk is unpartitioned, the program will automatically recognize it as destination and 
bypass this step. 

8.3.4 Partitioned destination disk 

On this step the program checks, if the destination disk is free. If not, you will be 
prompted by the Nonempty Destination Hard Disk window stating that the 
destination disk contains partitions, perhaps, with data. 

 
You can continue once existing partitions are deleted 

You will have to select between: 

Delete partitions on the destination hard disk – all existing partitions will be 
deleted during cloning and all their data will be lost. 

No, I do not want to delete partitions – no existing partition will be deleted 
making the cloning impossible. You will only be able to cancel this operation and 
return to select another disk. 

To continue select the first choice and click Next. 

 

Note that no real changes and data destruction will be performed at this moment! For now 
the program will just create a cloning script. All changes will be implemented only when you 
click Proceed, after the script is formed.  

8.3.5 Old and new disk partition layout 

If you have selected the automatic mode before, the program will ask you for 
nothing more. You will see the window graphically illustrating information (as 
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rectangles) about the source disk (partitions and unallocated space), and the 
destination disk layout. 

Along with the disk number some additional information is provided: capacity, label, 
partition and file system information. Partition types – primary, logical – and 
unallocated space are marked with different colors. 

Next you will see the cloning script. 

8.3.6 Old disk data 

If you selected the manual mode, the program will ask you what to do with the old 
disk: 

Create a new partition layout – create a new partition layout. All existing 
partitions and their data will be deleted (but they will also be cloned to the new 
disk, so you won’t lose them). 

Keep data – leave the old disk partitions and data intact. 

Destroy data – delete partitions (and data!) from the old disk. 

 

If you are going to sell, present, etc. your old disk, we recommend you to clean it 
from any information to avoid it getting into wrong hands. 

If you are going to keep the old disk for yourself and use it for data storage, you 
can create a new partition layout on it. In this case the disk will be ready right after 
cloning is complete. 

To protect yourself from unforeseen consequences, it would be better to leave the 
old disk data intact, as you will be able to delete them anytime you want later. 
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8.3.7 Destroying the old disk data 

If you selected to destroy the old disk data on the previous step, you will have to 
select the destruction method now: 

Quick – quick 1-pass destruction (takes several minutes). 

Normal – guaranteed multipass destruction (takes more time). 

 

The second method takes more time, but makes it impossible to recover data 
afterwards even with special equipment. 

The first method is less secure, but is still suitable for most cases. 

8.3.8 Selecting partition transfer method 

Acronis True Image Enterprise Server will offer you the following data transfer 
methods: 

As is; 

Proportional – the new disk space will be proportionally distributed between 
cloned partitions; 

Manual – you will specify the new size and other parameters yourself. 
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If you select to transfer information "as is", a new partition will be created for every 
old one with the same size and type, file system and label. The unused space will 
become unallocated. Further you will be able to use it to create new partitions or to 
enlarge the existing partitions with special tools (e.g. Acronis Partition Expert). 

As a rule, "as is" transfers are inexpedient, as they leave much unallocated space on 
the new disk. 

If you transfer data proportionally, each partition will be enlarged, according to the 
old and new disk capacities proportion. 

In some cases, some partitions may still be transferred "as is" or be enlarged to the 
less extent comparing to other. 

"As is" Acronis True Image Enterprise Server transfers unsupported and damaged 
file systems. 

FAT16 partitions are enlarged less than other, as they have 4 Gb size limit. 

Depending on the selected combination, you will proceed to either old disk 
partitioning window, or disk partition layout window (see below). 

8.3.9 Partitioning the old disk 

If you have selected Create a new partition layout before, it's now time to re-
partition your old disk. 

On this step you will see the current disk partition layout. Initially the disk has 
unallocated space only. This will change when you create new partitions. 
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Having completed the required steps, you will add a new partition. To create 
another one simply repeat these steps. 

If you made a mistake, click Back to redo. 

After you created the necessary partitions, uncheck the Create new partition in 
unallocated space box and click Next. 

8.3.10 Old and new disk partition layouts 

In the next window you will see rectangles indicating the source hard disk, including 
its partitions and unallocated space, as well as the new disk layout. 

 

Along with the hard disk number, you will see its capacity, label, partition and file 
system information. Different partition types, including primary, logical, and 
unallocated space are marked with different colors. 

 

If you have selected manual partition creation before, the partition layout will look different. 
This partitioning method is described below. 

8.3.11 Cloning script 

In the next window you will see the disk cloning script containing a list of briefly 
described operations to be performed. 
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Disk cloning script 

Cloning a disk, containing the currently active operating system, will require reboot. 
In that case, after clicking Proceed you will be asked to confirm the reboot. 
Canceling the reboot will cancel the entire procedure. 

Cloning a non-system disk or a disk, containing OS, not active at the moment, will 
proceed without reboot. After you click Proceed, Acronis True Image Enterprise 
Server will start cloning the old disk to the new disk, indicating the progress in the 
special window. You can stop this procedure by clicking Cancel. In that case, you 
will have to repartition and format the new disk or repeat the cloning procedure. 
After the operation is complete, you will see the results message. 

8.4 Cloning with manual partitioning 

8.4.1 Old and new disk partition layouts 

The manual transfer method enables you to resize partitions on the new disk. By 
default the program resizes them proportionally. 

In the next window you will see rectangles indicating the source hard disk, including 
its partitions and unallocated space, as well as the new disk layout. 

Along with the hard disk number, you will see its capacity, label, partition and file 
system information. Different partition types, including primary, logical, and 
unallocated space are marked with different colors. 
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To resize either partition, check the Proceed Relayout box. If you are satisfied 
with the partition layout shown, uncheck this box (if checked). Clicking Next you 
will proceed to the cloning script window. 

 

Be careful! Clicking Back in this window will reset all size and location changes that you've 
selected, so you will have to specify them again. 

First, select a partition to resize. It will become underlined red. 

Resize and relocate it on the next step. 

You can do this by both entering values to Unallocated space before, Partition 
size, Unallocated space after fields, by dragging partition borders, or partition 
itself. 

If the cursor turns to two vertical lines with left and right arrows, it's pointed at the 
partition border, so you can drag it. If the cursor turns to four arrows, it's pointed at 
the partition, so you can move it to the left or right (if there's unallocated space 
near it). 

Having provided the new location and size, click Next. You will be taken two steps 
back to the partition layout. Perhaps, you will have to perform some more resizing 
and relocation before you get the layout you need. 
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Chapter 9. Adding a new hard disk 

If you don't have enough space for your data, you can either replace the old disk 
with a new higher-capacity one (data transfers to new disks are described in the 
previous chapter), or add a new disk only to store data, leaving the system on the 
old disk. If the server has space for another disk, it would be easier to add it then 
clone. 

To add a new disk you must first install it into your server. 

9.1 Selecting a hard disk 

Select the disk, you've added to the server. 

 

 

This window might be bypassed if the program detects the new disk itself. In this case you 
will immediately proceed to the New partition creation. 

If there are any partitions on the new disk, they must be deleted first. 

Select Delete partitions on the destination hard disk and click Next to 
continue. 

9.2 Creating a new partition 

On the next step you will see the current partition layout. Initially all disk space will 
be unallocated. This will change after you add new partitions. 

 



 Adding a new hard disk 

 

Copyright © Acronis, Inc., 2000-2005 71

To create a new partition in the unallocated space, select Create new partition in 
unallocated space and click Next to perform steps required by the partition 
creation wizard. 

If you made a mistake at partitioning, click Back to redo. 

After you create the necessary partition layout, uncheck the Create new partition 
in unallocated space box and click Next. 

9.3 Disk adding script 

In the next window you will see the disk add script containing a list of briefly described 
operations to be performed. 

 
Disk add script 

After you click Proceed, Acronis True Image Enterprise Server will start creating 
and formatting new partitions indicating the progress in the special window. You 
can stop this procedure by clicking Cancel. In this case you will have to re-partition 
and format the new disk or repeat the disk add procedure. 

After the operation is complete, you will see the results message. 
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Chapter 10. Scheduling 
Acronis True Image Enterprise Server allows you to schedule tasks, so you won't 
have to remember the last time you imaged your disks. Acronis True Image 
Enterprise Server will do this for you to guarantee the safety of your data. 

You can create more than one independent scheduled tasks. 

For example, you can image your work documents daily, and backup the application 
disk only weekly. 

This reduces the number of imaging operations and provides nearly the same data 
safety. 

To create scheduled tasks, use Acronis True Image Enterprise Server scheduler: 

 Select View → Active tasks in the main menu. You will see a new window with 
all scheduled backup tasks. If no tasks have been created, the list will be empty; 

 Click Schedule Task in the Active Tasks section to invoke Schedule Task 
Wizard; 

 Follow Wizard instructions to create and set up new partition/disk backup task. 

10.1 Creating scheduled tasks 

10.1.1 Selecting partitions 
In the Partition selection window you see the current partition layout. To select a 
partition check the respective box. To select all disk partitions check the disk box. At 
that all the related partitions will be checked. You can also select one or more hard 
disks or a random disk/partition combination. 
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Having selected partitions and/or disks, click Next. Note that this button is disabled 
until at least one partition or disk is selected. 

Other parameters are set further in the same way as described in the Chapter 4 
related to image creation. 

10.1.2 Selecting task periodicity 

After you set image parameters, you must set task execution periodicity. 

 

Do not start automatically - a task will not be executed. You can select this 
variant to leave it disabled. 

Daily – a task will be executed daily at the specified time (selected on the next 
step). 

Weekly - a task will be executed weekly or in some weeks at the specified time and 
day (selected on the next step). 

Monthly - a task will be executed monthly at the specified time and day (selected 
on the next step). 

One time only - a task will be executed once at the specified time and day 
(selected on the next step). 

When my computer starts - a task will be executed at OS startup. 

When I log on - a task will be executed, when you log in the OS. 

When my computer shuts down - a task will be executed before every 
shutdown or reboot. 

When I log off - a task will be executed, when you log off the OS. 
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Some variants might be disabled depending on the operating system. 

10.1.3 Setting up daily execution 

If you select the daily execution, you will have to specify some additional 
parameters. First, the Start time (hours and minutes). 

In the Perform this task group select days to execute tasks on: 

Every day; 

Weekdays; 

Every x days – once in several days (specify the interval). 

 

You can execute the task even if your server is turned off at the specified time. To 
do this select Perform this task when the computer restarts, only if the 
computer was turned off at the selected time. In this case the task will be 
executed at the nearest startup. 

10.1.4 Setting up weekly execution 

If you select the weekly execution, you will have to specify some additional 
parameters. First, the Start time (hours and minutes). 
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Specify periodicity in the Every x weeks (each week, in a week, etc.) 

Check weekdays to execute the task on. 

You can execute the task even if your server is turned off at the specified time. To 
do this select Perform this task when the computer restarts, only if the 
computer was turned off at the selected time. In this case the task will be 
executed at the nearest startup. 

10.1.5 Setting up monthly execution 

If you select the monthly execution, you will have to specify some additional 
parameters. First, the Start time (hours and minutes). 

In the Perform this task group select time to execute tasks on: 

Day – on the specified date. 

The... – on the specified weekday (e.g. second Tuesday or fourth Friday); selected 
from drop-down lists. 
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You can execute the task even if your server is turned off at the specified time. To 
do this select Perform this task when the computer restarts, only if the 
computer was turned off at the selected time. In this case the task will be 
executed at the nearest startup. 

10.1.6 Setting up one time execution 
If you select the weekly execution, you will have to specify some additional 
parameters. 

First, the Start time (hours and minutes). 

Second, the Start date. 
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You can execute the task even if your server is turned off at the specified time. To 
do this select Perform this task when the computer restarts, only if the 
computer was turned off at the selected time. In this case the task will be 
executed at the nearest startup. 

10.1.7 Entering user name 

Under Windows NT SP6, 2000, XP, 2003 you will have to specify the name of the 
user that owns the executed task, otherwise no scheduled execution would be 
available. 

 

In the upper field enter user name. Enter password twice in two fields below. 

10.1.8 Task scheduled successfully 

You have finished scheduling a task. The wizard will again remind you the details of 
the task provided. 

To close the wizard and return to the main window click Finish. The task created 
will be named New task. You can rename it appropriately. 

10.2 Managing scheduled tasks 

If you select a task in the Active Tasks window, you will see its details in the left 
part. And the Operations menu and toolbar will be extended with Edit, Schedule, 
Delete, and Rename icons. 

Rename allows you to give your task a more appropriate name. 

Delete is used to delete selected task with confirmation. 
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Edit is used to change any task parameters. This is performed in the same way as 
creation with two exceptions. 

First, there will be specified parameters instead of the default, so you won't have to 
enter them again. 

Second, after you make changes you will be asked about execution order. I.e. you 
will be able to change image creation parameters like location without touching its 
execution periodicity and time (though you can change it as well.) 

If you want to change only periodicity and time, select Schedule. At that you will 
have to perform only scheduling steps leaving image settings the same. 
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Chapter 11. Command-line mode and 
scripting 

Acronis True Image Enterprise Server supports the command-line mode, as well as 
the GUI mode, and can be used to execute special scripts.  

11.1 Working in the command-line mode 

An administrator might need a console interface in some situations. Acronis True 
Image Enterprise Server supports this mode with TrueImageCmd.exe utility. The 
file is located in a folder where Acronis True Image has been installed, by default it 
is C:\Program Files\Acronis\TrueImage. 

11.1.1 Supported commands 

TrueImageCmd has the following format: 

TrueImageCmd /[command] /[option1] [option2]… 

The following commands are supported (each command may be accompanied by 
additional options): 

1. create 
Creates an image file with the specified file name. A complete image is created by 
default. Use the /incremental option to create an incremental image. 

Options 

/progress:[on | off] 

Shows/hides the progress information (percent completed). It is shown by default. 

/filename:[filename] 

Sets the image filename. 

/password:[password] 

Protects an image with a password. 

/net_user:[username] 

Specifies a user name when creating an image on a network drive. 

/net_password:[password] 

Specifies a user password when creating an image on a network drive. 

/harddisk:[disk number] 
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Specifies the hard disks to include into the image file by numbers. The list of 
available hard disks is provided by the /list command. An image may contain 
data of more than one hard disk. In that case, separate disk numbers by commas, 
e.g.: 

/harddisk 1,3 

/partition:[partition number] 

Specifies the partitions to include into the image file by numbers. The list of 
available partitions is provided by /list. Partition numbers are specified as <disk 
number>-<partition number>, e.g.: 

/partition: 1-1,1-2,3-1 

/file_partition:[partition letter] 

Specifies the partition where the image file will be stored (by letter or number). This 
option is used with /filename:file_name. In that case the file name must be 
specified without drive letter or root folder. For example: 

/file_partition:D /filename:"\1.tib” 

/raw 

Use this option to create an image of a disk (partition) with unrecognized or 
unsupported file system. This will copy all disk/partition contents sector-by-sector. 
Without this option only the sectors containing useful system and user data are 
imaged. 

/compression:[0…9] 

Specifies the image compression level. It ranges from 0 to 9 and is set to 3 by 
default. 

/incremental 

Sets the image type to incremental. If there is no a basic image file to append an 
incremental one, a complete image will be created. 

/split:[size in MB] 

Splits image file into parts of the specified size. 

/reboot 

Reboots the server after the operation is completed. 

/log:[file name] 

Creates a log file of the current operation with the specified file name.   

2. deploy 
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Restores a disk or partition from an image. 

Options 

/filename:[filename] 

Specifies the name of the image file to restore. 

/net_user:[username] 

Specifies a user name when restoring an image from a network drive. 

/net_password:[password] 

Specifies a user password when restoring an image from a network drive. 

/file_partition:[partition letter] 

Specifies the partition where the image file is stored (by letter or number). This 
option is used with /filename:file_name. In this case the file name must be specified 
without drive letter or root folder. For example: 

/file_partition:D /filename:"\1.tib” 

/password:[password] 

Specifies the password for the image file (if required). 

/harddisk:[disk number] 

Specifies the hard disks to restore by numbers.  

/partition:[partition number] 

Specifies the partitions to restore by numbers. 

/target_harddisk:[disk number] 

Specifies the hard disk number where the image will be restored. 

/start:[start sector] 

Sets the start sector for restoring a partition to the hard disk unallocated space. 

/size:[partition size in sectors] 

Sets the new partition size (in sectors). 

/type:[active | primary | logical] 
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Sets the new partition type. By default (if this option is not defined) an active 
partition is created on the first hard disk and logic partitions on other disks. 

/target_partition:[partition number] 

Specifies the target partition number for restoring a partition over the existing one. 
If the option is not specified, the program assumes that the target partition number 
is the same as the partition number specified with the /partition option. 

/reboot 

Reboots the server after the operation is completed. 

/log:[file name] 

Creates a log file of the current operation with the specified file name.   

3. list 

Lists the available drives and partitions. 

Options 

/filename:[filename] 

Lists the image file contents. 

/password:[password] 

Specifies the password for the image file (if required). 

4. clone 

Clones a hard disk. 

Options 

/harddisk:[disk number] 

Specifies a source hard disk which will be cloned to the new hard disk.  

/target_harddisk:[disk number] 

Specifies the target hard disk number where the source hard disk will be cloned. 

5. explore 

Connects an image file as a virtual drive. 

Options 

/filename:[image file name] 
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Specifies an image file to be connected as virtual drive. 

/password:[image password] 

Specifies the password for the image file (if required). 

/partition:[partitions list] 

Specifies a list of partitions to be mounted as virtual drives. Without this option, all 
partitions stored in the image file will be plugged.  

/letter 

Assigns letters to the mounted drives. This option is used with /partition option 
only. 

/net_user:[username] 

Specifies a user name when exploring an image from a network drive. 

/net_password:[password] 

Specifies a user password when exploring an image from a network drive. 

/log:[file name] 

Creates a log file of the current operation with the specified file name.   

6. unplug 
Unplugs image file connected as virtual drive. 

Options 

/letter:X 

Specifies the virtual disk to be disconnected by letter. 

/letter:all 

Disconnects all virtual drives. 

7. create_partition 

Creates a new partition. 

Options 

/harddisk:[disk number] 

Specifies the hard disk where to create a partition. 
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/filesystem:[FAT | FAT 16 | FAT 32 | NTFS | NONE] 

Sets the file system for the new partition. The default value is NONE. 

/label:[partition label] 

Sets the new partition label. 

/type:[active | primary | logical] 

Sets the new partition type. By default (if this option is not defined) an active 
partition is created on the first hard disk and logic partitions on other disks. 

/start:[start sector] 

Sets the start sector for the new partition. 

/size:[partition size in sectors] 

Sets the new partition size (in sectors). 

/reboot 

Reboots the server after the partition is created. 

8. delete_partition 

Deletes a partition. 

Options 

/partition:[partition number] 

Specifies the number of partition to delete. 

/reboot 

Reboots the server after deleting the partition. 

/log:[file name] 

Creates a log file of the current operation with the specified file name.   

9. resize_partition 

Resizes or/and moves the existing partition. 

Options 

/partition:[partition number] 
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Specifies the partition number. 

/start:[start sector] 

Sets a new start sector for the partition. 

/size:[partition size in sectors] 

Sets the new partition size (in sectors). 

/reboot 

Reboots the server after resizing/moving. 

/log:[file name] 

Creates a log file of the current operation with the specified file name.   

10. asz_create 

Creates Acronis Secure Zone on the selected drive. 

Options 

/harddisk:X 

Specifies the hard disk number where Acronis Secure Zone will be created. 

/partition:[partitions list] 

Specifies partitions from which free space will be taken for Acronis Secure Zone 
creation. 

/size:[ASZ size in sectors] 

Sets the Acronis Secure Zone size (in sectors). If this size is not specified, it will be 
set as average between maximal and minimal values, including unallocated spaces 
on the all listed partitions. 

/asz_activate 

Activates Acronis Secure Zone after creation (or, rather, activates Acronis Startup 
Recovery Manager). 

 

/asz_activate option will not take effect, if the system partition is resized during Acronis 
Secure Zone creation. Use /asz_activate command to activate Acronis Secure Zone after it 
is created. 

/reboot 

Reboots the server after the Acronis Secure Zone is created. 
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/log:[file name] 

Creates a log file of the current operation with the specified file name.   

11. asz_delete 

Deletes Acronis Secure Zone from your hard disk. 

Options 

/partition:[partitions list] 

Specifies partitions to which free space will be added after the Acronis Secure Zone 
is deleted. 

/log:[file name] 

Creates a log file of the current operation with the specified file name.   

12. asz_activate 

Activates Acronis Secure Zone (or, rather, activates Acronis Startup Recovery 
Manager). This command may also be used as an option with ‘asz_create’ 
command. 

13. verify 

Verifies image archive data integrity. 

Options 

/filename:[filename] 

Specifies the name of the image file to verify. 

/password:[image password] 

Specifies the password for image file (if required). 

/net_user:[username] 

Specifies a user name when verifying an image from a network drive. 

/net_password:[password] 

Specifies a user password when verifying an image from a network drive. 

14. help 

Shows help for commands. 
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11.1.2 TrueImageCmd.exe usage examples  
1. Create image 

TrueImageCmd /create /filename:"C:\Test\1.tib" /partition:2-
1,1-3 

• This will create an image named 1.tib of the partitions 2-1 and 1-3. Image will 
be saved to c:\Test\ folder. 

TrueImageCmd /create /filename:"\Test\1.tib" /partition:2-1,1-
3 /file_partition:3-1 

• This will create an image named 1.tib of the partitions 2-1 and 1-3. Image will 
be saved to partition 3-1. 

TrueImageCmd /create /filename:"C:\Test\1.tib" 
/password:qwerty /harddisk:2 /reboot /raw /incremental 
/compression:5 /split:640 /progress:off 

• This will append an incremental image to the image named 1.tib of hard disk 2. 
Image will be saved to c:\Test\ folder, protected with password “qwerty”, split 
into parts of 640 MB, and contain all cluster data. Image compression level is 5. 
The server will be rebooted after the operation is completed. 

2. Restore image 
TrueImageCmd /deploy /filename:"C:\Test\1.tib" /partition:2-1 

• This will restore partition 2-1 from image 1.tib. 

TrueImageCmd /deploy /filename:"C:\Test\1.tib" 
/password:qwerty /harddisk:2 

• This will restore hard disk 2 from image 1.tib, protected with password ‘qwerty’. 

TrueImageCmd /deploy /filename:"C:\Test\1.tib" /partition:2-1 
/target_partition:1-1 

• This will restore partition 2-1, stored in image 1.tib, to partition 1-1. 

TrueImageCmd /deploy /filename:"C:\Test\1.tib" /partition:2-1 
/target_harddisk:3 /start:0 /size:64000 /type:logical 

• This will restore partition 2-1, stored in image 1.tib, to hard disk 3. A new logical 
partition will be created on disk 3 from 0 to 64000 sector. 

TrueImageCmd /deploy /filename:z:\Server30Cdrive.tib 
/partition:1-1 /target_partition:2-1 /type:active 
/password:123qwe 

• This will restore partition 1-1, stored in image Server30Cdrive.tib, protected with 
password ‘123qwe’, to partition 2-1. The restored partition will be of active type. 

3. List 
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TrueImageCmd /list 

• This will list available partitions. 
4. Clone 

TrueImageCmd /clone /harddisk:2 /target_harddisk:3 

• Clone hard disk 2 to hard disk 3. 

5. Delete partition 
TrueImageCmd /delete_partition /partition:2-1,2-2 /reboot 
/log:deleting.txt 

• This will delete partitions 2-1 and 2-2, create log file ‘deleting.txt’ and reboot the 
server, when the operation is completed. 

6. Explore image 
TrueImageCmd /explore /filename:\\myserver\backup\mybackup.tib 
/net_user:john /net_password:qwerty 

• This will connect all images, stored in file mybackup.tib on the network drive, as 
virtual drives. 

11.1.1 Command-line mode usage under DOS 

For usage in the MS-DOS compatible environments Acronis True Image Enterprise 
Server includes TrueImageCmdDos.exe utility. It is located in a folder where 
Acronis True Image has been installed, by default it is C:\Program 
Files\Acronis\TrueImage. 

11.2 Scripting 

11.2.1 Script execution parameters 

Scripts are executed by the TrueImageTerminal.exe utility located in the Acronis 
True Image installation folder (i.e. C:\Program Files\Acronis\TrueImage). This utility 
is also used to monitor backup progress. 

TrueImageTerminal.exe execution parameters: 

TrueImageTerminal.exe [arguments] 

Arguments include the following: 

/help – outputs help information about TrueImageTerminal.exe parameters. 

/progress – outputs progress of backup operations run either from Acronis True 
Image Server graphics user interface, or from the script. 

/execute: [script file name] – executes a script. If there are several scripts to be 
executed, they are queued. An example for executing MyBackup.tis script: 
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TrueImageTerminal.exe/execute:C:\MyBackup.tis 

/nowait – an optional script execution argument. Enables to terminate 
TrueImageTerminal before backup is finished. Example: 

TrueImageTerminal.exe /execute:C:\MyBackup.tis /nowait 

 

By pressing Ctrl+C you can force backup progress output off and switch 
TrueImageTerminal to background operation. 

 

You can terminate backup operation executed by TrueImageTerminal by pressing Ctrl+B.

11.2.2 Script structure 

Scripts are written in XML language and you can use the following tags: 

Source. Specifies partitions or disks to be imaged. Letters assigned to partitions 
must be used without colon. Disk numbers correspond to their system numbers. To 
create images of several partitions or disks, use the SOURCE tag for each of them, 
e.g.: 

<source letter=”C”/> 

<source letter=”D”/> 

<source disk =”1”/> 

<source disk =”2”/> 

Target: Specifies name and location of an image file, e.g.: 

<target file-“E\Mybackup2.tib” username=”username” 
password=”password”/> 

username and password parameters are optional. They are used to access 
networked resources. 

As a target for image files you can indicate CD-R/RW or tape drive. 

Options. This tag can be used with a number of additional parameters: 

Compression: specifies backup compression level. Can be None, Low, 
Normal, High. 

Incremental: specifies if you need to create an incremental image file. If equal to 
”false” (or “0”), the complete image file will be created. If there's already a file 
with the name specified, it will be replaced without warnings. If equal to “true” 
(or “1”) and there's already a file with the name specified, an incremental image 
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will be created. Otherwise the program will create a complete image file. The 
default value for this parameter is “true”. 

Description: adds a description to an image file. The comment must be a single 
string (though its length is not limited.) 

Split: splits a large image file into a number of smaller files of the specified size, 
which can be provided in bytes, kilobytes, megabytes, etc. 

Password: adds password protection to an image file. 

11.2.3 Script usage examples 

The following example illustrates the usage of a script to backup two partitions 
(logical drives), C and F. mybackup2.tib is specified as an incremental image file. 
The High compression level is selected and the image is to be split into 650MB parts 
for recording to CD-R/RW media. Password protection will also be added. The entire 
script must be located between the <backup> and <backup/> tags. 

<?xml version="1.0" encoding="utf-8" ?> 

<backup> 

<source letter=”C” /> 

<source letter="F" /> 

<target file="e:\mybackup2.tib" /> 

<options compression="high" incremental="true" 
description="this is my backup" split="650 Mb" password="" /> 

</backup>. 

The script for backing up to tape(tapeN specifies the tapes numbers): 

<?xml version="1.0" encoding="utf-8" ?> 

<backup> 

<source letter=”C” /> 

<source letter="F" /> 

<target cdrw="\taperecorder\\\.\tape0|||” /> 

<target cdrw="\taperecorder\\\.\tape1|||” /> 

<options compression="high" incremental="true" 
description="this is my backup" /> 

</backup>. 
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Chapter 12. Other operations 

12.1 Checking images 

To be assured your images are not damaged, you can check their integrity. To do 
this select Check Image in the Tools group (expand it if it's not) or click Check 
Image on the toolbar. You will see the first wizard window. Click Next to continue. 

12.1.1 Selecting image for checking 

In this window you will see the complete list of connected storage devices, including 
hard disks and any other drives. Using the standard Windows Explorer locate the 
image file to be checked and select it. 

Its name will appear in the File Name field and the Next button will be enabled. 

 

Click Proceed to continue. The checking progress will be indicated in the new 
window. 

You can cancel checking by clicking Cancel. 

After checking is complete you will see the results window. 
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12.2 Creating bootable media 

In some cases, Acronis True Image Enterprise Server can be run only from a special 
bootable diskette or CD. Such a case might be if your server does not boot up 
normally. 
You can create bootable media during or after the installation. 
For this, you will need a CD-R/RW blank, several formatted diskettes (the bootable 
media wizard will tell you the exact number), or any other media your server can 
boot from, such as a Zip drive. Click Create Bootable Media on the toolbar or the 
sidebar, or select Create Bootable Media from the Tools menu. 
You can also create bootable media without loading Acronis True Image 
Enterprise Server itself by selecting Programs  Acronis  True Image  
Bootable Rescue Media Builder from the Start menu. 
You will see the bootable media wizard that will ask you to select either complete, 
or safe loader version. The latter doesn't have USB, PC card (PCMCIA), SCSI drivers 
and is useful only in case the complete version doesn’t work. 
After you create a boot disk, identify it and keep it in a safe place. 

12.3 Viewing logs 

Acronis True Image Enterprise Server allows users to view its working logs. They 
can provide information about scheduled image creation results, including failure 
reasons if any. Logs are created only for partition (disk) image creation operations. 

To invoke the log window, select Show log on the toolbar or from the Tools menu. 

The log browsing window contains two panels: the left one features the log list, 
while the right one – selected log contents. 

 

The left panel can contain up to 50 logs. If there’s more, you can browse the list 
using the More and Less buttons with the left and right arrows. 
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To delete a log select it and click Delete. 

If any step was terminated by an error, the corresponding log will be marked with a 
red circle with a white cross inside. 

The right window features the list of steps contained in the selected log. You can 
flexibly setup list parameters to display only messages of particular type, particular 
columns, or select sorting order. 

To sort messages by a particular column, click its header (click again to reverse 
order) or the Arrange Icons by button (the second from the right) and select the 
desired column. 

To select columns to display right-click the headers line or left-click the Choose 
Details button, and check columns to display. 

The three buttons to the left control message filters: the white cross in the red circle 
filters error messages, the exclamation sign in a yellow triangle filters warnings, and 
the “i” in the blue circle filters information messages. 

You can also change column width by dragging their borders with mouse. 
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Chapter 13. Troubleshooting 

13.1 Recovering Acronis True Image Enterprise Server 

If Acronis True Image Enterprise Server ceased running or produces errors, its files 
might be corrupted. To recover the program, run Acronis True Image Enterprise 
Server installer again. It will detect Acronis True Image Enterprise Server on your 
server and will ask you if you want to recover (update) or remove it. 

Click Recover and click Proceed. 

13.2 Frequently asked questions 

What storage devices does Acronis True Image Enterprise Server support 
for keeping backups? 

Partition backups can be created on both hard disks, and other storage devices 
supported by Windows NT 4.0 SP6, 2000, 2003. 

What is the purpose of specifying image file size? 

The thing is that server hard disk is the fastest and most effective storage device. It 
can write a disk (partition) image considerably faster than any other device, e.g. 
CD-RW. Having specified image volume size equal to about 650–700Mb you can 
quickly create image files on your hard disk to burn them to CD-R/RW afterwards. 
This allows doing the whole task much faster. 

What devices can a system partition be restored from, if Acronis True 
Image Enterprise Server is loaded from its bootable diskette of CD? 

Acronis True Image Enterprise Server supports any connected hard disks, a wide 
variety of IDE, SCSI, FireWire (IEEE-1394), USB (1.0, 1.1, 2.0), PC card (PCMCIA) 
devices, as well as CD-R/RW, DVD-RW, DVD+R/RW magneto-optical disks, Iomega 
Zip, Jaz, etc. 

Can Easy CD Creator 4.x–5.0 impede Acronis True Image Enterprise 
Server ? 

Easy CD Creator 4.x and 5.0 automatically installs the old and unsupported by Roxio 
Take Two® backup utility removed from Easy CD Creator 5.1 and newer. If Acronis 
True Image Enterprise Server detects this utility, it shows you the following 
message in the beginning of image creation. 

"Can’t create the image of the logical disk, as it’s already used by a running 
application. Please close all other applications and try again." 
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We recommend you to update your Easy CD Creator up to 5.1 or newer and/or 
completely remove Take Two®. 

For more information visit 
http://www.roxio.com/en/support/roxio_support/taketwo.html 

I created an image on CD-R(RW) discs, but when I try to browse it 
Acronis True Image Enterprise Server tells me it can’t connect this image 
as a virtual disk. 

The current version of Acronis True Image Enterprise Server can connect images 
only if their files are located in the same place. If your image is located on several 
CD-R(RW) or hard disks, you will have to copy all its files to the same location on 
your hard disk. 

If it is an incremental image, you will need all the previous images and the initial full 
image. 

Why I am unable to create images after SafeGuard Easy was installed? 

Backing up disks/partitions, encrypted by SafeGuard Easy, will be possible after you 
reinstall Acronis True Image Enterprise Server. Acronis True Image Enterprise 
Server is compatible with SafeGuard Easy, the only limitation is that it must be 
installed after SafeGuard. The image will contain volumes without encryption. 

I ran Acronis True Image Enterprise Server from a bootable disk to 
restore a partition (disk) from an image located on the network drive, but 
couldn’t find the necessary computer. 

If there’s at least one computer shown in the Network Neighborhood, try to access 
the required computer by typing its address in the Filename line like 
\\computer\folder. 

If there’s no Network icon in the My Computer, it means either network problems, 
or wrong drivers that Acronis True Image Enterprise Server tries to use. Contact our 
technical support (support@acronis.com) and provide all network adapter 
specifications and manufacturer’s name. 

I ran Acronis True Image Enterprise Server from a bootable disk to 
restore a partition (disk) from an image located on the network drive, but 
it just kept asking me for username and password. What should I do? 

In some cases, especially when there’s a domain controller installed in the network, 
you have to specify computer or domain name before username. You must enter 
username like COMPUTER\USER or DOMAIN\USER. 

I received the "Can’t create image of disk D:, because it’s already used by 
applications or contains bad sectors" error message, where D: stands for 
my logical disk, when I tried to create an image under Windows. 

Your logical disk might contain bad sectors. We recommend you to run a complete 
disk surface test. Type “chkdsk /R D:” in the command line and reboot if needed. 

mailto:support@acronis.com
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How can I prepare Windows NT, 2000 or 2003 for cloning or transferring 
to a server with different hardware? 

Before you clone or transfer Windows to another server, you must prepare it with 
Microsoft System Preparation Tool (sysprep). The reasons to do this are described 
in the 298491 article of Microsoft Knowledge Base: “One problem from duplicating 
an installation of Windows 2000 is that each cloned computer has the same security 
identifier (SID) and computer name. This may prevent the cloned computers from 
functioning correctly in a workgroup or a domain. To work around this problem, 
administrators use the System Preparation Tool (Sysprep.exe) to remove 
configuration settings that are unique to the computer such as the computer name 
and SID." This problem also relates to Windows NT 4.0 SP6 and Windows XP, so 
you should prepare these OS in a similar way. 

You can download Microsoft System Preparation Tool from www.microsoft.com or 
extract from deploy.cab located on Windows XP installation CD. 

Below is a brief instruction on how to prepare your hard disk for cloning or 
transferring to another server: 

1. Create Acronis True Image Enterprise Server bootable media using the 
corresponding wizard in the Acronis True Image Enterprise Server menu. 

2. Run sysprep.exe. You can specify the following as command line parameters: 

-nosidgen — if you plan to delete all data from the old disk and/or don’t plan 
to use the old and new disks in different servers simultaneously; 

-mini — if you plan to transfer your OS to a server with different hardware. 

3. Insert Acronis True Image Enterprise Server bootable disk into the drive and 
load the program to create an image of the prepared disk. 

4. Install the new disk into your server or provide image access from the new 
server. 

5. Boot from the bootable disk again and restore the image to the new disk or 
server. 

6. Reboot. 

We recommend you to read Microsoft’s sysprep articles available to the following 
OS: Windows NT 4.0 SP6, Windows 2000, Windows 2003. 

How can I burn Acronis True Image Enterprise Server images to DVD 
discs? 

Acronis True Image Enterprise Server can burn images to DVD discs under 
Windows, if you have DVD UDF recording software installed. The DVD disc must be 
formatted. Currently the program supports at least the following DVD recording 
software: 

Roxio DirectCD — optional component of Roxio Easy CD Creator; 

http://www.microsoft.com/
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Ahead InCD — available on Nero website freely for Ahead Nero Burning Rom users 
(usually bundled with Nero); 

Veritas DLA and all its OEM versions (e.g. HP DLA); 

Pinnacle InstantCD/DVD. 
In general the program also supports all other DVD UDF burst recording software, 
but the aforementioned applications was tested by Acronis for compatibility with 
Acronis True Image Enterprise Server . 

To enable image recording to DVD in Acronis True Image Enterprise Server you 
should do the following: 

Install DVD UDF recording software; 

Format DVD discs. DVD+RW and DVD-RW discs can be formatted in any of the 
aforementioned applications, while DVD+R formatting is currently supported by 
Roxio DirectCD only; 

Run Acronis True Image Enterprise Server , insert formatted DVD disc into your 
DVD+RW or DVD-RW drive and create an image. No other special actions are 
required. 

Images stored on DVD discs can be restored from both under Windows, and when 
Acronis True Image Enterprise Server is loaded from its bootable media. 

Besides, there’s another way to burn an image to a DVD disc. Using Acronis True 
Image Enterprise Server you can create a hard disk image on your hard disk to burn 
it using the installed DVD recording application to a DVD disc afterwards. You will 
be able to restore images from such discs from both under Windows, and when 
Acronis True Image Enterprise Server is loaded from the bootable media. 

13.3 Technical support 
Users of legally purchased copies of Acronis True Image Enterprise Server are 
entitled to free e-mail technical support from Acronis. If you have installation or 
working problems that you can’t solve by yourself using this manual and the 
readme.txt file, e-mail the technical support team. 

Before you do this, you will have to register your copy at 
http://www.acronis.com/registration/ or by mail. 

When e-mailing technical support, you must provide the registration number of your 
Acronis True Image Enterprise Server copy, bundled with the program. 

For more information visit http://www.acronis.com/support/

Technical support email address: support@acronis.com. 

Acronis Inc., 
395 Oyster Point Boulevard, Ste 115 
South San Francisco, CA 94530 
http://www.acronis.com 
info@acronis.com 

http://www.acronis.com/registration/
http://www.acronis.com/support/
mailto:support@acronis.com
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